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Warning!

Electronic charts displayed by the chart plotter are believed to be accurate and reliable, but they are not intended
to substitute for the official charts which should remain your main reference for all the mat- tets related to
the execution of a safe navigation.

For this reason we would like to remind you that you are required to carry on board and use the officially
published and approved nautical chatts.

Caution

@ Please read through this manual before the first operation. If you have any questions, please contact the
Company customer service or your local dealer.

O The chartplotter is not built water proof. Please give attention to avoid water intrusion into the
chartplotter. Water damage is not covered by the warranty.

© Extensive exposute to heat may result in damage to the chart plotter.

® Connection to the power source with reversed polarity will damage the chatplotter severely. This
damage may not be covered by the warranty.

© The chartplotter contains dangerous high voltage circuits which only experienced technicians can
handle.

® The C-MAP C-CARD are available from your local dealer.

® We will not be liable for etrors contained herein, ot for incidental or consequential damages in
connection with the performance or use of this material.

® Exposute of display to UV rays may shorten life of the liquid crystals used in your plotter. This
limitation is due to the current technology of the LCD displays.
Avoid ovetheating which may cause loss of contrast and, in extreme cases, a darkening of the screen.
Problems which occur from overheating are reversible when temperature decreases.

Cleaning procedute for the plotter screen

Cleaning of the plotter screen is a very important operation and must be done carefully. Since the surface is
covered by a antiteflective coating, the procedure for cleaning all the sutfaces can be pet- formed using the
following procedure: You need a tissue or lens tissue and a cleaning spray containing Isopropanol (a normal
spray cleaner sold for the PC screen, for example PolaClear by Polaroid). Fold the tissue or lens tissue into a
triangular shape, moisten the tip and use the index finger behind a corner to move the tissue across the
surface, in overlapping side to side strokes. If the tissue is too wet, a noticeable wet film will be left in its
path and you will need to repeat the process. If too dry, the tissue won't glide easily, and may damage the
surface.
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The chart plotter can store a fix when the distance from its last stored position is greater than a defined
distance or after a defined time. A line connects such points and represents the past course, called the Track

of the ship (see Par. 4.4).

m Tracks & Routes

Recommended and established routes for ships at sea, including traffic separation schemes, deep water
routcs, ....

m TRN = Turning

The difference between COG and BRG. If COG is 80° and BRG is 75°, TRN is 5° Left.

B TTG = Time To Go

The estimated time needed to reach your destination, based on your cutrent speed and the distance to
destination.

m TWA = True Wind Angle

Direction of the air relative to fixed point on the heart.

m TWS = True Wind Speed

Speed of the air relative to fixed point on the heatt.

m User Point

Place on the chartidentified by its coordinates and displayed on the screen with a reference symbol (see
Mark, Waypoint and Event).

@ UTC = Universal Time Coordinated

A time scale based on the rotation of the earth that is used by most broadcast time setvices.

@ UTM = Universal Transverse Mercator

Metric Grid system used on most large and intermediate scale land topographic charts and maps.

m VAD = Value Added Data

The Value Added Data (VAD) is a collection of additional cartographic objects which are not present
on the original paper chart (from which the electronic chart derives). These objects have been obtained
from other sources (that C-MAP believes to be reliable) and then merged to the electronic charts in
order to provide more information useful for the navigation.

VAD object can be any cartographic objects and it can be distinguished from the official-chart-objects
from the Quick Info. A dedicated icon is shown on the Quick Info window to indicate that the object
quetied is a VAD.

The same icon is also shown on the Full Info page and in addition the extended text Value Added Data
is shown on the details of the VAD object.

B VRM = Variable Range Marker

Circle with radius set by the user and center as cursor position.

m VDOP = Vettical Dilution Of Precision

Itis the index for position-fixing accuracy.

m VMG = Velocity May Good

The Velocity May Good is the component of the velocity that is in the direction of the destination.

m WAAS = Wide Area Augumentation System

The Federal Aviation Administration (FAA), in cooperation with other DOT organizations and DOD,
is augmenting the GPS/SPS with a satellite-based augmentation system, the WAAS. It will provide a
signal-in-space to WAAS users to support en route through precision approach navigation. After achieving
initial operational capability, the WAAS will then be incrementally improved over the next years to
expand the area of coverage, increase the availability of precision approaches, increase signal redun-
dancy and reduce operational restrictions.
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tival of pulses from those stations would be observed. The TD is measured from the time of reception of the
master station signal to the time of reception of the slave station signal.

m Tide

The periodic rise and fall of the surface of oceans, bays, etc., due principally to the gravitational interac-

tions between the Moon and Earth.

m Tide & Currents

The new worldwide database with tidal stream information is now available with MAX C-CARDs.

When data/time s available, Tidal stream arrows are shown on the chatts, indicating the ditection and

Fig. A.1a - Tides & Currents

If no data/time s available from the GPS ot the chatt plottet is not in Simulation mode, the icon on the map is
generic one.
The colour of the arrow denotes the strength of the current as follows:

0Oto0.1kn - O < Yellow
0.2to 1.0kn - < Yellow
1.1t0 2.0 kn - < Orange
2.1t03.0kn - < Orange
3.1t09.9kn - . Red

Fig. A.1b - Tides & Currents table

When the chart plotter receives a valid position fix, the Tide icons are shown on the charts on the basis of the
current date and time: the screen displays and changes arrows as date/time changes.

m Tide Info

The Tide Info feature is the combination of a new tide heights database that will be included within
new C-CARDs and new features which calculate the tide graph for all primary and secondary pots
wotld-wide. This function can calculate the tide heights for any past or future date and as a by-product
of this calculation will also display the Maximum and Minimum Tide height and time for the day
selected plus the times of Sunrise and Sunset. At some chart levels, the chart plotter will display a new
Tide Diamond Symbol for every Port or tide point in the database covered by that particular C-CARD
(see Par. 3.4.4).

m Time Line

The location where the ship will be after the time set by the user.

m Track

As long as the chart plotter is connected to a positioning instrument, it stotes all points in its memory.
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On some objects, such as bridges, the image associated can represent the Diagram representing the shape

of the objects and the various characteristics (length, heigh, type of bridge etc.).

I I 4
SNSRI R e

Introduction

Fig.A.1 - Pictures and Diagrams
B Port Info

The Port Info function is a combination of a new Port Info database containing all the relevant Safety and
Navigational information normally found in good pilot books and a new presentation software which displays

special Port Facility Symbols.

m Ports & Setvices

Areas along shote with facilities for mooring, downloading and uploading of ships, generally sheltered
from waves and winds. Port installations are piers, whatves, pontoons, dry docks, cranes... .

m Route

Sequence of Waypoints connected by segments. Among the available Routes, only one is the active
Route, which is shown by a straight line and arrows to indicate the direction. The first Waypoint of the

Congratulations on your purchase of the chart plottet!

If you have not used a position-finding instrument before and intend to use
your chart plotter for navigating, we suggest you should read this User Manual and
make sure you are familiar with its contents.

The User Manual is divided into three main parts. Chapter "Before You
Begin" introduces you to the basic information to get you start using the chatt plot-
ter. Chapter "For the New User" should be read first to become familiar with your

new instrument. Chapter "For the Experienced Uset" introduces the advanced fea-

active Route is surrounded by a circle (see Par. 4.1.1). £ the chart ol
tures of the chart p otter.

@ RTCM = Radio Technical Commission for Maritime Setvices
The data format created by the Radio Technical Commission Maritime to transmit Differential GPS
corrections.

Do of di 1.1 CONVENTIONS

m Simulation
Used in order to use your chart plotter without input data. It generates a display with a moving vessel,
so that you can practice using the controls in safety.

Throughout this User Manual, the labelled keys ate shown in capitals letters
enclosed between single inverted commas, for example 'MENU'; the software keys are

m SNR = Signal to Noise Ratio shown in small capitals letters enclosed between single inverted commas, for example
The ratio of the magnitude of a signal that of the noise (interference). 'Eprr.

m 30G = Speed Over Ground Menu operations are in bold characters listed by keys sequence with the menu
A calculation of the rate of movement of the ship over the ground. names enclosed between inverted commas, for example 'MENU' + 'MENU'

B Speed + "ADVANCED" + 'ENTER' + "FIX & COMPASS" + 'ENTER' means: press the
The current velocity at which you are travelling, relative to a ground location. 'MENU' key for two times, using the Joystick to select the ADVANCED menu and press
B SPS = Standard Positioning Setvice 'ENTER ' to go in it; then using the Joystick to select the FIX & COMPASS menu and press
The civilian-access signal broadcast by the GPS satellites. 'ENTER' to goinit.

B STR = Steering Terms underlined, for example Target, are explained in the Appendix

The difference between COG and CTS. If COG is 25° and CTS is 30°, then STR is 5° Right. "Terms",

@ TD = Time Difference

Loran-C positions are determined by precise timing of the intervals between reception of pulses trans-
mitted by pairs of stations in the selected chain. Between any two stations a ship must be located
somewhere along a line of possible positions where the measured Time Difference, TD, between ar-
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1.2 FEATURES

The chart plotter is a computer specifically designed for nautical use but, more
precisely, to ease and speed up all calculations, which so far have been done manually. If
connected to a positioning instrument, the chart plotter displays the current position, the
speed, and the heading of the boat and its Track. The user information like Waypoints,
Marks and Tracks can then be stored on a SD Card and can be recalled at any time. On the

screen ate shown navigation data and carto- graphic information obtained from electronic
charts of C-MAP C-CARD.

When the package containing the chart plotter is first opened, please check it
for the following contents (if any parts are missing contact the dealer the chart plot-
ter was purchased from):

» Power supply and I/O 8 pins cable 1,5 mt./5.9"; cable code CBCOFS0804
» Desktop brackets kit

« Two I/O 6 pins cables 1 mt./3.9"; cable code CBCOFS0603

» Fuse 2A + Fuse hlder (2pcs)

+ External packaging

+ User Manual

C-MAP C-CARD (cartography data cards) are available through your local
dealer. For additional information on C-MAP Cartography visit web site at
WWW.C-map.com.

1.2.1 SPECIFICATIONS
12.1.1  MAIN CHARACTERISTICS

Recordable Individual points

+ User Points : 5000
» Type of User Points 016
Routes
- Routes : 3000
+ Max User Points per Route: 3000
Tracking
« Tracks 5
+ Points per Track : 10000
+ Step by Distance :0.01,0.05,0.1,05,1,2,5,10 Nm
+ Step by Time 1, 5,10, 30 Sec, 1, 3, 5 Min

Cartographic Functions
+ Wotldwide Background
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® HDOP = Hotizontal Dilution Of Precision

It is the index for position-fixing accuracy. The smaller the HDOP value, the more accurately the
position can be fixed

B Home

In Operating mode (called also Navigate mode) all operations refer to the ship's position.

m Landmarks

Any prominent object such as monument, buiding, silo, tower, mast, ..., on land which can be used in
determining a location or a direction.

m Latitude

The angular distance North or South of the equator measured by lines encircling the earth parallel to
the equator in degrees from 0° to 90°.

m LAT/LON

Coordinate system using Latitude and Longitude coordinates to define a position on earth.

m LOG

Speed of the vessel relative to the water.

m Longitude

The angular distance East or West of the prime meridian (Greenwich meridian) as measured by lines
perpendicular to the parallels and coverging at the poles from 0° to 180°.

B Loran
The Loran Chains are groups of transmitting stations that use timed radio pulse transmissions.

m Magnetic Deviation

The angle between the Magnetic North and the Compass North.

m Magnetic Variation

The angle between the magnetic and geographic meridians at any place, expressed in degrees West or
East to indicate the direction of magnetic North from true North. It changes from point to point, and
(at the same point) with time.

m Mark

Reference points related to cursor position (see Par. 4.2).

m Natural Features

Any topographic feature formed by the action of natural processes: coastlines, relief, glaciers, ....

m Navigate

Operating mode (called also Home mode) all operations refer to the ship's position.

m NMEA-0183

The NMEA-0183 Data Interface Standard was developed by the National Marine Electronics Associa-
tion of America. It is an international standard that enables equipment from many different manufac-
tures to be connected together and to share information.

m OSGB = Ordnance Sutvey of Great Britain

A coordinate system describing only Great Britain. Generally used with GBR36 datum, which also
describes only Great Britain. This coordinate system cannot be used in any other part of the world.

m Pictures and Diagrams

The MAX data format allows assigning one or more image to any cartographic object. These Pictires
are typically used to facilitate the identification of cartographic objects or places around the map: they
can be the landscape layout nearby a hatbor, the shape of a bridge ot of a buoy etc.
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m Cotrection

To compute fix error in automatic mode, place cursor on ship's real position and then follow the
procedure (compute cotrection). Itis also possible to compute the fix error in manual mode (correction
offset). Once you computed the error, you can turn the fix correction On or Off.

m CTS = Coutse To Steer

The optimum direction the boat should be steered in order to efficiently make headway back to the
courseline while also proceeding toward the destination Waypoint.

m Cultural Features

Any man-made topographic feature as built-up area, buildings, roads, ....

m Current

Non-periodical movement of sea-water, generally horizontal, due to many causes such as different
temperatures and prevalent winds. Some may be temporary, others permanent.

m Datum

The Latitude and Longitude lines printed on any map are based on certain models of the shape of the
carth: these models are called Datum or Coordinate Systems. There are many different Datum in use,
each one gives different Lat/Ton positions for an identical point on the surface of the earth.

B Default

Indicates a value or a setting which is used if the user has not defined a particular value. You can modify
this value using the menu settings.

m Depth Contours

Imaginary lines connecting points of equal water depth.

m DGPS = Differential GPS

Provides even greater positioning accuracy than standard GPS.

m Drift

Horizontal velocity of the water surface.

m DSC

DSC (Digital Selective Calling) is a method of establishing a VHF radio call; it is used to announce
urgent maritime safety information broadcasts. This system allows mariners to instantly send Distress
Call ot/and Position Request to the othet vessels equipped with a DSC transceiver within range of the
transmission.

m DTG = Distance To Go

The actual distance to reach the Target.

m EBL = Electronic Bearing Line

A dot line with direction set by the user and otigin as cursor position.

m Event

User Point that refers to the ship's position. It s simply a way of marking where the boat s (see Par. 4.2).
m File

Collection of information (of the same type) stored on a SD Card. Each file must have a unique name,
ideally one that describes its contents. Filenames are kept in a directory on each SD Card (see Par. 4.7).
m GPS = Global Positioning System

It is a satellite based navigation system operated by the US Department of Defense. It gives the naviga-
tor a position 24 hours a day, 305 days a year under any weather conditions.

m HDG/HEAD = Heading

The horizontal direction in which a ship actually points or heads in any moment (see also COG).
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» Detailed Map by using C-MAP C-CARD
» Coordinates System (ddd mm ss, ddd mm.mm, ddd mm.mmm, UTM, OSGB, TD)
« Map Datum
« Data Window mode
» Display Mode (Full, Simple, Fishing, Low, Custom)
« Marine
Place Names, Name Tags, Nav-Aids & Light Sectors, Attention Areas, Tides &
Currents, Seabed Type, Ports & Services, Tracks & Route
+ Depth
Depth Range Min/Max
- Land
Land Elevation, Land Elevation Values, Roads, Points Of Interest
« Chart
Lat/Lon Grid, Chart Boundaties, Value-Added data, Chart Lock
» Underwater Objects
Underwater Objects Limit, Obstructions, Diffusers, Rocks, Wrecks
Map Menu
» Zoom Type
» Fonts & Symbols
+ Perspective View
« Live Nav-Aids
+ Map Orientation (North, Coutse)
« Mixing Levels
+ Safety Status Bar
« Palette
« Currents Prediction
Fix Functions
- WAAS
» Fix Corttection (manual and automatic)
- Position Filter
» Speed Filter
« Fix Datum
+ Compass Calibration
» Bearings True and Magnetic
- Variation user selectable
+ Static Navigation
Report Functions
» Depth Graph page
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+ Depth Graph Full page

» Navigation Data page (change the fields)

+ 3D Road page (change the fields)

» GPS Status page

» GPS Data page

+ User Points List page

- About page

Special Functions

+ C-Link, C-Weather Setvice and C-Staff

« AIS Menu

- DSC Menu

+ Fish Finder capability if connected to Fish Finder Black Box

- Radar functions display if connected to Radar scanner

- Auto Info

- Find (Nearest Setvice, Tide Stations, Wrecks, Obstructions, Port By Name, Port
By Distance, Lakes By Name, Lakes Information, POIs)

+ A/B Function

« EBL/VRM Function

+ Navigation to Destination

« Speed Unit (Mph, Kts, Kph)

+ Distance Unit (Km, Nm, Sm)

+ Depth Unit (Ft, FM, Mt)

+ Altitude Unit (Ft, FL, Mt)

» Temperature Unit (°C, °F)

+ Date & Time Setup (Local, UTC)

+ Keypad Beep selection

+ Alarms Handling
Arrival Alarm, XTE Alarm, Anchor Alarm, Depth Alarm, Heading Alarm,
Grounding Alarm, Grounding Depth Limit, Grounding Alarm Range, Ground-
ing Alarm Report, External Alarm

+ MOB Function

+ Simulation
Speed, Heading, Date, Time, Cursor Control, Simulation On/Off

Auxiliary Memory

» SD Card

Interface

- 51/0 ports
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Terms

This section explains the terms that may be unfamiliar to the reader.

B Artival Time

The estimated time of day you will reach your destination, based on your current speed and track from
GPS.

m Attention Areas

Attention Areas are areas in which special attention by the mariner is required, because of natural or
man-made hazards, or sailing regulations and restrictions. Moteover a special symbol () is placed inside
the area selecting On option. This is valid also for the categories: FISHING FACILITY, MARINE
FARM/CULTURE, MILITARY PRACTICE AREA, RESTRICTED AREA, SEAPLANE LAND-
ING AREA. When the area is small, it is identified only by the boundaty.

m AWA = Apparent Wind Angle

Direction of the air relative to the moving ship.

m AWS = Apparent Wind Speed

Speed ot the air relative to the moving ship.

m Azimuth

The angular measurement from the horizon to a satellite or another object.

m Beacon

A prominent, specially constructed object forming a conspicuous vertical mark as a fixed aid to navigation.
m BRG = Bearing

Itis the angle between the North (True or Magnetic) and a destination. It represents the direction to
follow.

m Buoy

A floating object moored to the sea bottom in a particular (charted) place, as an aid to navigation.

m Chain

Selects the preferred chain. The Loran chains ate groups of transmitting stations that use timed radio pulse
transmissions. In each of these chains there is a master station and two ot mote slave or secondary stations.
Stations belonging to a same chain transmit pulses in timing groups: a different time base identifies each
chain. The time base of each chain is the Group Repetition Interval or GRI. This GRI identifies the chain
in unique mode. For example the GRI = 4990 identifies the chain of Central Pacific zone.

m COG = Course Over Ground

Direction of the path over ground actually followed by a vessel.
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6.5.4 MODEM TEST

To check the Modem connections.

6.5.5 SERIAL PORTS

If you are having problems receiving data from the position-finding instru-
ment, this test should help determine the problem.

©® Change Parameters
Allows to change the parameters of the serial interface. This menu allows to
select the Port (Signal Source) between Port 1, Port 2 or Port 3, the Baud Rate
between 4800 or 9600, the Data Bits (Word Length) between 7 or 8, the Parity
between even, odd or none, the Stop Bits between 1 or 2. Default settings are:
Port = Port 2, Baud Rate = 4800, Data Bits = 8, Parity = odd, Stop Bits = 1.

© Input Data Display

Allows the chart plotter to act as a computer terminal and display the incoming
data exactly as it received. If the data displayed on the screen is unrecognizable,
you may have selected the wrong input parameters for your particular receiver.
Check your receiver manual to be sure that you have selected the proper inter-
face format. If the screen is blank, you may have a broken connection and no
data is being received. Use "ZOOM IN' to stop (ot continue after pause) data
displaying, 'ENTER' to show data in hex or ASCII mode (normal ot small) and
'CLEAR to exit.

6.5.6 EXTERNAL ALARM

To check the External Alarm signal.

6.5.7 SD CARD
To check the SD Card handling.
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1.2.1.2 PHYSICAL CHARACTERISTICS
Chart plotter size (inch/mm)

+ 15"x 13.5"x 8.9" (381.5mm x 342mm x 221mm)
Chart plotter weight

+45Kg
SD Card

+ 16 MB or more
LCD display

» Color : LCD 12.1" TFT Colot, polatized

» Resolution : 800 x 600 pixels
Video Input

» PAL or NTSC video signals automatically selected
Power consumption

- L.6A @10V
Power supply

+ 10 - 35 Volt dc, 16 Watt
Operating Temperature Range

» From 0°C to 55°C (from 32°F to 131°F)
Memory

+ Non volatile with battery back-up
Keyboard

+ Backlighted, silicon rubber

1.3 BASICS

The chart plotter is controlled by using 24 keys. There is also a Joystick to move
a cursor across the screen.

Fig. 1.3 - The chart plotter
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As you press a key, a single audio beep confirms the key action; every time the
key pressed is not valid, three rapid beeps sound indicates that no response is available.
Note that it is possible to enable (On) or disable (Off) the keypad beep following the

procedure:
>» 'MENU' +'MENU' + "GENERAL" + 'ENTER' + "Keypad Beep" + 'ENTER'
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appears, the RAM is physically damaged.

® RAM Clear

To clear internal memory. If the chart plotter exhibits unusual behaviour, or
appears to be malfunctioning, it may be possible to correct the problem by clear-
ing RAM.

This operation will erase all Marks, Events, Routes, stored track plots and desti-
nations. It will also return all selections (Input Data Format, Autopilot selection,
etc.) to original default values. To confirm to clear RAM press 'ENTER' again
(but if at this time you do not wish to cleart RAM press 'CLEAR).

6.5.2 DIM menu

To select the preferred value for contrast and backlight.
® Contrast
Each time you pressed the Joyszick to right, the screen will decrease brightness,
instead of to left it will increase brightness.

0 Backlight
To set the backlight. Operates in similar mode as Contrast.

6.5.3 CARTRIDGES
To check the C-CARD and its connector.
® Background ROM
To test the WorldWideBackground. If there is not a malfunction, the code of the
Background and the message "OK" are shown.

©® C-CARD Test

To test the C-CARD. There are three possible situations:

1. if there is 2 C-CARD inserted in the slot and thete is not 2 malfunction, the
name of the C-CARD zone and the message "OK" are shown.

2. if there is a C-CARD inserted in the slot, but it is a damaged C-CARD, the
name of the C-CARD zone and the message "Faulty" are shown.

3. if there is not any C-CARD inserted in the slot, the message "not present” is
shown.

©® C-CARD Connector
Indicates if there is a malfunction in the connector. It is used only in production.
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lease and Cartography information available in the About page.
>» 'MENU' +'MENU' +"About..." + 'ENTER'
Note

The information shown on this page depends on the software running on the chart plotter and on the C-
CARD:s inserted.

6.4.3.1 World Background Charts

The internal background charts can be updated to include the MAX A and B
level charts which provide improved marine data, rivers, lakes, terrestrial data (major
streets , highways , railways, etc...), Nav-Aids, depth areas, tertitorial water areas, etc... by
reading them from a special data C-CARDs (contact your local dealer). All units must have
the WorldWide Background upload function that is activated from the system.

Worldwide Background Update
The System Update menu is entered from the About page. To select this menu fol- low

the procedure:
»  DPlug the special data C-CARD + 'MENU' + 'MENU' + "About..." + 'ENTER' +
'MENU' + "UppaTE WoRLDWIDE CHARTS" + 'ENTER'

6.5 SYSTEM TEST

If you have connected your position-finding device according to the instruc- tions,
and chosen the proper menu selection for your device, and ate still having problems with
your chart plotter, the extended auto-test should help determine the problem. Make sure
the chart plotter is turned Off. While pressing and holding any other key, turn the chart
plotter On. A new menu will appear on the display. Use the Joystick to select the preferred
test: this will display in reverse video and with the relative menu window. To choice the test
press 'ENTER'. To exit from any submenu press 'CLEAR'. To exit from the System Test
turn Off the chart plotter.

6.5.1 RAM menu

This test verifies the integtity of the memories and if preferred during this test all
the internal memory can be erased and the default setting restored.

© RAM Test
To verify the integrity of the RAM. If on the screen the message "ERROR"
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Before You Begin

This chapter provides basic information to get you start using the chart plot- ter; it
will help you to become familiar with the chart display and the functions of the controls
before you start using the chart plotter.

2.1 THE KEYBOARD

The POWER key

Press and hold 'POWER' down for 1 second to turn the chart plotter On. Press
and hold 'POWER' down (once the chart plotter has been turned On) for 3 seconds turns
the chart plotter Off.

The — X + key

Press 'DISPLAY +/-' to adjust the LCD and keypad backlight.
The = @ + key

Press 'CONTRAST +/-' to adjust the LCD contrast.

The [E9) key

Numeric key or moves cursor top left corner.
The m key
Numeric/letter key or moves cutsot top.

The (R key

Numeric/letter key or moves cursot top tight corner.
The @ key
Numeric/letter key or moves cursor left.
The (J@ key
Numeric/letter key or centers the map at the current cutsor position. If
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Navigate (Home) mode is set the map is already centered on the map display.
The (3 key

Numeric/letter key or moves cursor tight.
The key

Numeric/letter key or moves cursot bottom left corner.
The @D key

Numeric/letter key or moves cursot bottom.
The () key

Numeric/letter key or moves cursot bottom right corner.
The key

Numeric key.

The PAGE key

Press PAGE' to select the configuration you wish among cartography and text
area, Depth Graph pages, GPS Data page, GPS Status Page, Navigation Data page, 3D
Road Data page.
The MENU key

Press MENU' one time to select the MAP Menu; press MENU' two times to
select the FUNCTIONS Menu. When into a Menu, moving the Joystick to the right
enters a selection, moving the Joystick to the left clears the function.

If pressing'MENU' for 3 seconds from chart and data page allows to custom-
ize all data fields shown in the selected page.
The GOTO key

Press 'GOTO' to select the Goto function.
The EVENT key

Press and release 'EVENT/MOB' to place Event marker. Long press
'EVENT/MOB' to insert the MOB (Man OverBoard); long press 'EVENT/MOB'
when the MOB is already present deletes it.
The "L key

Places EBL and VRM.

The TRACK key

Opens Track menu to select Track, switches Track On/Off, delete Track, change
Track colot/pattern, change Track recording step, switches Track display On/Off.
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6.4 TROUBLESHOOTING

The following is a brief guide to some of the problems you may experience while
using the chart plotter with common solutions.

6.4.1 PROBLEMS AND SOLUTIONS

The chart plotter does not turn On — Make sure that the correct voltage (10-35 volt
dc) is present. Check also that the polarity is correct. Refer to the Par. 2.2.

The chart plotter does not turn Off — If, after a POWER' pressure (for at least 3
seconds) the chart plotter does not turn Off, then turn Off the voltage.

The chart plotter does not respond to any command — Try to turn Off, and then turn
On. If the problem persists, erase the memory (see Par. 6.5.1).

The chart plotter does not get a valid fix — Make sure that no metal obstacle is placed
around the chart plotter acting as a shield for the antenna. If, after 15 minutes, the chart
plotter does not get the fix, turn it Off and On again.

The chart plotter screen becames very datk after a long exposute to direct sun-
light — Control the contrast (see Par. 2.3).

6.4.2 WHEN NOTHING ELSE WORKS

The list above should allow you to solve most of the operating problems you are
likely to encounter. Simply disconnecting the chart plotter from power for a moment may
solve your problem as well.

If this does not help, you can try one additional memory clear option. This
is a factory default RAM Clear that should only be tried after all other attempts have
been made. When using the RAM Clear feature, you will loose all user stored infor-
mation and the chart plotter will default to factory settings. Before this step, you
have the option of saving user Marks, Track history and Routes to a SD Card (this is
an optional purchase from your dealer). To perform a RAM Clear see Par. 6.5.1.

6.4.3 IF YOU NEED ASSISTANCE

If you still need assistance, call your local dealer, reporting the Software Re-
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6.3 EXTERNAL CONNECTORS

POWER & /O
PIN|/WIRE COLOR |FUNCTION
1 |BLACK GND COMMON
2 |RED POWER INPUT+ (10-35 Vdc) GND
3 |WHITE INPUT 1+ AUTOPILOT
4 |GREEN GND
5 |GRAY OUTPUT 2+ e L0
6 |YELLOW OUTPUT 1+
7 |BROWN INPUT 2+
8 |BLUE EXTERNAL ALARM QUTPUT +
Fig. 6.3 - POWER & I/O connector
POWER & 1/0 POWER SUPPLY
POWER & 1/0 CABLE LI )
PIN| CABLE COLOR | FUNCTION
1 |BLACK GND/COMMON
2 |RED PWR + (10-35 Vdc) - +
8 |BLUE OUTPUT EXTERNAL ALARM + (0pen Collectar) et X J00MA |
Fig. 6.3a - External Alarm connector
SMART GPS ———.
POWER & /O POWER SUPPLY SENSOR
PIN|WIRE COLOR|FUNCTION + -
1 [BLACK GND COMMON ——j T 7
2 |RED POWER INPUT+ (10-35 Vdc *
3 |WHITE INPUT 1+ J GPS SENSOR
4 |GREEN GND < T FUNCTION
5 |GRAY OUTPUT 24 POWER+
6 [YELLOW QUTPUT 1+ GND COMMON
7 |BROWN INPUT 2+ GPS TX+
8 |BLUE EXTERNAL ALARM QUTPUT+ » PS RX+
Fig. 6.3b - GPSconnector
AUXHN /O CABLE
PIN|WIRE COLOR|FUNCTION ‘ GND
1 [BLACK GND COMMON ] et
2 |RED POWER OUTPUT+ (10-35 Vdc)
3 |WHITE INPUT 4+ jL Ex;ll-ﬁRENAAL
4 |GREEN GND DEVICE
5 |GRAY OUTPUT 5+
& [YELLOW OUTPUT 4+
7 |BROWN INPUT 5+ » RX4
8 |BLUE EXTERNAL ALARM OUTPUT+
Fig. 6.3c - AUXIN 1/0 connector
VIDEO INPUT
CAM CONNECTORS 1=GND COMMON
PIN-OUT 2=POWER+ (10-35Vdc)
(on Unit) 3=SIGNAL
EE#JM
Fig. 6.3d - Video Input connector
V DEO OUTPUT
PIN| FUNCTION
1 GND
2 | vcC
3 R
4|6
5 B
5] HSYNC
7 VSYNC
a8 N.C.
9 BRIGHTNESS CONTROL
Fig. 6.3e - Video Output connector
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The aear key

Press 'CLEAR' to exit from menu or to leave a menu without making changes. If you
are not into 2 menu, sets the Navigate mode (Home).

The enrer key
Press 'ENTER' to select the preferred option, to confirm selection, to create

Objects (Mark, Waypoint, A-B).

The @ and keys

ress 'Z IN' shows more details of a smaller area, by changing the chart
scale and zooming in on your display. Press "ZOOM OUT" to operate simi- latly to the
"ZOOM 1IN, except in reverse, changing the scale and showing a wider, otherwise less
detailed view.

The ‘ineo key
Press 'INFO' to select Info function.
|'|j//=\\\ji'|
The “—” Joystick
The Joystick moves the cursor about on the display screen, quickly and accu- rately.

It also scrolls the preferred option in the menu page(s).
If in Navigate (Home) mode, it allows to exit from Navigate mode.

2.1.1 FUNCTION KEYS

When the cursor is placed over any User Point or any cartographic object, a
window containing the information about the selected object i1s shown on a variable
location of the screen (not covering the cursor icon). At the same time some Func- tion
Keys (up to five) are shown on the bottom of the page. The Function Keys ate associated
to the function that can be applied to the selected object. Each Function Key shows a
number and the name of the function.

For example when the cursor is placed over a Matk, the information win-
dow with Coordinates, Name, Icon and all other Mark information is shown. The
following Functions Keys are shown on the bottom of the map display (see the
following Fig 2.1.1).

Pressing any numerical keys from '1" to '5', the function associated to the
selected number is executed. Otherwise pressing any numerical key not active (not
associated to any function) 3 beeps will be sounded and the Function Keys are kept
shown. Pressing 'CLEAR' the Functions Keys are removed from the screen, press-
ing any other key the Functions Keys will be closed and the function associated to
the pressed key will be executed.
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Fig.2.1.1 - The Function Keys

2.2 TURNING THE CHART PLOTTER ON AND OFF

Before powering On the chart plotter, check for the correct voltage (10-35 volt
dc) and the correct connections with the positioning instrument:

POWER & I/O CONNECTOR
PIN# | CABLE WIRE COLOR | FUNCTION

BLACK GND/COMMON
RED +10-35 Vdc

Fig. 2.2 - Power On

2.2.1 TURNING ON
Press and hold POWER' for 1 second. The chart plotter emits one rapid beep

sound, and a title page is opened: the software name and version (*), the World- wide
Cartography database version and the code and version of the C-CARDs in- serted are
shown.

Note (*)

The software version is subject to change without notice. This User Manual is valid anyway.
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For the Technician

6.1 DIMENSIONS

(= x
Ji \ r;\ \
7
| S _ K‘ v
- 38L.5(15Y) > 34.5 (1.4")«»+—186.5(7.5")
6.2 INSTALLATION AND REMOVING
— Tl '7_._,4- [
:L '-’l“\.
?
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Fig. -2.2.1 - Title page
After a few seconds, the first of the two Caution Notice pages is displayed,
reminding you the chat plotter is only an aid to navigation and should be used with

appropriate prudence. The electronic charts are not intended to substitute for the official
charts. Then the cartographic screen is displayed.

2.2.2 TURNING OFF

Press POWER' and hold for 3 seconds: a countdown timer appears on the
screen, if you release the key before the countdown timer reaches zero, the chart plotter
will remain On.

2.3 CHANGING BACKLIGHT AND CONTRAST

You can modify the i mtenslt} of the backlight and contrast to make reading easy and
comfortable. By 'DISPLAY +/-'and 'CONTRAST +/-'itis possible to increase or decrease the
brightness: each time you press the key "+", the light value is increased to the max value, if
you press the "-", light value is decreased to the min value.

WARNING m
At very low temperatures the CCFL backlight may not glow properly. Allow a few minutes for it to warm up.

2.4 SELECTING THE LANGUAGE

It is possible to select the language in which you wish information to be displayed
(for screen labels, menus and options, but it is not affect the map informa- tion). The
default setting is English.
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» 'MENU'+ 'MENU' + "GENERAL" + 'ENTER' + "Language" + 'ENTER' the Radar functions.
Choose the language you prefer and press 'ENTER' to confirm. To select the Radar menu, first select one of the pages related to the Radar

and then once the Radar page is selected, access the Radar menu by pressing:
> 'MENU'

55 EXTERNAL CONNECTIONS For more information see the specific User Manual.

Note

The Radar display page is available only if the Radar is connected and powered On.

2.5.1 GPS CONNECTIONS

Select one of the available Ports and connect the GPS wires to the selected port
signals. For example to connect the GPS to POWER & I/O connector (setial Port 1) see
the following picture:

POWER & /O POWER SUPPLY SENSSR”
PIN|WIRE COLOR |FUNCTION + -
1 |BLACK GND COMMON — v v
2 |rReD POWER INPUT+ (10-35 Vdc
3 |WHITE INPUT 1+ —47 \I j. J GPS SENSOR
4 |GREEN GND < T ] FUNCTION
5 |GRray OUTPUT 2+ POWER+
6 [vELLOW OUTPUT 1+ }—‘ GND COMMON
7 [BROWN INPUT 2+ GPS TX+
8 [BLUE EXTERNAL ALARM OUTPUT+ » PS RX+

Fig. 2.5.1 - GPS Connection on serial Port 1

Then choose your preferred setting following the procedure:
» 'MENU'+'MENU'+"ADVANCED" + 'ENTER' + "INPUT/OUTPUT" + 'ENTER'
+ "Port 1 Input" + 'ENTER'

Select your preferred setting among the NMEA available settings NMEA 1200-
N81-N, NMEA 4800-N81-N, NMEA 4800-N82-N, NMEA 9600-O81-N, NMEA 9600-
N81-N (the default setting is 4800-N81-N) and press ENTER' to confirm.

2.5.2 AUTOPILOT CONNECTIONS

Select one of the available Ports and connect the AUTOPILOT wites to selected
port signals. For example to connect the AUTOPILOT to PORT 1 connec- tor (setial Port
2) see the following picture:

POWER & /O
PIN|WIRE COLOR |FUNCTION
1 |BLACK GND COMMON
2 [RED POWER INPUT+ (10-35 Vdc)| - GND
3 |WHITE INPUT 1+ AUTOPILOT
4 |GREEN GND
5 |GRAY OUTPUT 2+ e L
6 |YELLOW OUTPUT 1+
7 |BROWN INPUT 2+
8 |BLUE EXTERNAL ALARM QUTPUT+

Fig.2.5.2 - Autopilot Connections on serial Port 2
Then choose your preferred setting following the procedure:

>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "Pott 2 Output" + 'ENTER'
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Date and Time
Distance and Bearing from current vessel's position
Pressing 'ENTER' it is possible, by selecting "DELETE" deletes the DSC
icon from the DSC Log page, otherwise by selecting "DSC LOG" the DSC Log page
is shown.

5.7 C-STAFF MENU

The C-Staff functions ate based on STAFF Concept ® (Satellite Tracking Aided
Fleet Fishing). The STAFF Concept ® is designed for professional fishing purpose to
allow monitoring the position of the vessels of a fleet from each vessel (the fleet may have
until 20 vessels max).
> 'MENU' +'MENU' +"ADVANCED" + 'ENTER' + "C-STAFF" + 'ENTER'
For more information see the specific User Manual.

5.8 FISH FINDER MENU

The chart plotter combined with the sonar performance of the Fish Finder is one
of the most advanced marine navigation system available.
To select the Fish Finder menu, first select one of the pages related to the
Fish Finder and then once the Fish Finder page is selected, access the Fish Finder
menu by pressing:
> 'MENU'
For more information see the specific User Manual.

Note
The Fish Finder display page is available only if the Fish Finder is connected and powered On.

5.9 RADAR SETUP MENU

The Radar consists of a scanner unit which illuminates targets with micro- wave
energy and then collects the echoes from those targets. The scanner unit in- cludes the
Radar antenna, transmitter, receiver and necessary electronics. The scan- ner unit is
connected to a chart plotter equipped with software capable of displaying
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Select your preferred setting among the NMEA available settings NMEA
0183 4800-N81-N, NMEA 0180, NMEA 0180/CDX (the default setting is NMEA
0183 4800-N81-N) and press 'ENTER' to confirm.

2.5.3 EXTERNAL NMEA CONNECTIONS

Select one of the available Ports and connect the EXTERNAL NMEA wires to
selected port signals. For example to connect the EXTERNAL NMEA to PORT
2 connector (serial Port 3) see the following picture:

AUX-N /O CABLE
PIN[WIRE COLOR[FUNCTION [ GND
1 [BLACK GND COMMON T T%+
2 [RED POWER OUTPUT+ (10-35 Vdc)
3 |WHITE INPUT 4+ [ EXTERNAL
4 |GREEN GND NMEA
5 |GRAY OUTPUT 5+ DEVICE
6 |YELLOW OUTPUT 4+
7 |BROWN INPUT 5+ » RX+
8 [BLUE EXTERNAL ALARM OUTPUT+
Fig. 2.5.3 - External NMEA Connections on serial Port 3

Then choose your preferred setting for input format following the procedure:
>» 'MENU'+'MENU'+"ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +'ENTER'
+ "Port 3 Input" + 'ENTER'

Select your setting among the NMEA available settings NMEA 1200-N81-
N, NMEA 4800-N81-N, NMEA 4800-N82-N, NMEA 9600-O81-N, NMEA 9600-
N81-N (the default setting is 4800-N81-N) and press 'ENTER' to confirm.

Now set the output format to the same input format following the procedure:
> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "Pott 3 Output" + 'ENTER'

2.5.4 C-COM CONNECTIONS

To connect the modem C-COM to the chart plotter follow the procedure:

D .
16\%32?{? {@ 0 POWER 8 1/0 CONNECTOR
0/ PIN| CABLE COLOR| FUNCTION
~ 1 |BLACK GND COMMON
> |rED PWR + (10-35 Vdc)
— '& 3 [wHITE Used by C-COM
“— 4 |GREEN Used by C-COM
\ Q,LQ\‘\ 5 |GRrRAY OUTPUT2+
6 |YELLOW Used by C-COM
7 [BROWN INPUT2+
8 |BLUE QUTPUT EXTERNAL ALARM+

Fig. 254 - C-COM Connection

Note
The connection is valid for the C-COM IR and C-COM RS232 tgo.

2. Into the Input/Output menu, set the C-COM for Port 1 as follows:
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» 'MENU'+'MENU'+"ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +'ENTER'
+ "Port 1Input" + 'ENTER' + "C-COM" + 'ENTER'

Also the modem C-COM can be connected to any other Ports, in this case
set the format for the selected Port.

2.5.5 EXTERNAL ALARM CONNECTION

To connect the External Alarm device see the following picture:

POWER & 1/0 POWER SUPPLY
POWER & I/0 CABLE L3N ]
PIN| CABLE COLOR [FUNCTION
1_|BLACK GND/COMMON
G 2 [RED PWR + (10-35 Vdc) P, o
8 |BLUE OUTPUT EXTERNAL ALARM+ (Open Callector) -

Fig.2.5.5 - External Alarm Connection

Once the connection is active, to enable the External Alarm follow the procedure:
> 'MENU' + 'MENU' + "ALARMS" + 'ENTER' + "External Alarm" + 'ENTER' +
"ON" + 'ENTER'

2.6 ADDITIONAL C-CARDS

The chart plotter has a built-in world map. But during navigation you will need to
use larger scale charts with detailed information. These are available using the C-CARDs.
The chart plotter allows you to install four of them at the same time, because there are four
slots. You can insert and remove C-CARDs while a chart is displayed; but you do not
insert or remove C-CARDs while map is redrawing.

Note
During normal operations the C-CARD should not be removed since the chart plotter may lock up.

2.6.1 INSERTING C-CARD
Hold the C-CARD by the short inclined side so that you can see the C-MAP

B\

I
5 )
6@“{\-\‘\0\-\ .

)

label.

NCLINED SIDES
=

Fig.2.6.1 - Inserting C-CARD (1)
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sel Name, Contact Name and Phone number to any MMSI (Maritime Mobile Service Identity)
so that, when a DSC Distress Call or Position Request is received, the name of the vessel is
displayed in place of the MMSI number - a unique number that is assigned to a DSC radio
station for use in emergency situations :

VESSEL NAME MMS| CONTACT PHONE
SCORPION 0046712433 ERICH SMITH 12372133456
STRIKE 99 0036612458 |JIMMY PAGE 22832178345
JUPITER 0036612459 |ROBERT PIO 22114433001
SARA 10063412123 | SUSANNE | 44332211001

ADD DELETE DELETE ALL

Fig.5.6.2.2 - Example of DSC Directory page

Edit
>» 'MENU'+'MENU'+"DSC" +'ENTER' + "DIRECTORY" + 'ENTER' + "EDIT" +
'ENTER'
Edit the fields of any existing entry in the Directory: Vessel Name, MMSI number,

contact and phone number.

Add
> 'MENU'+'MENU'+"DSC" +'ENTER' + "DIRECTORY" + 'ENTER' + "ADD" +
'ENTER'
Add a new entry to the Directory.
Delete
> 'MENU'+'MENU'+"DSC" +'ENTER' + "DIRECTORY" +'ENTER' + "DELETE"
+'ENTER'
Delete the selected entty.
Delete All
>» 'MENU'+'MENU' +"DSC" + 'ENTER' + "DIRECTORY" + 'ENTER' + "DELETE
ALL" + 'ENTER'

Deletes all entries in the page.

5.6.3 QUICK INFO ON DSC ICONS

Placing the cursor on the Distress Call or Position Request icon, the following
information is displayed:
Vessel Name/MMSI Number
Position
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DATE LAT NAME

TME . __LONG M1 SHowN
03-03-01 3330505 N
08:31 PM 118°18.529 W 0080457645 NO
03-04-01 33°34.167 N ROY

s ent o son

GLR-ONE GLR-ALL
HIDE POSITION REQUEST

Fig.5.6.2.1 - Exemple of DSC Log page

Press 'DEST' to set the navigation on the selected DSC point. Other avail- able
functions ate:

Locate

> 'MENU' + 'MENU' + "DSC" + 'ENTER' + "LOG" +

'ENTER' + "LOCATE" + 'ENTER'
Centers the map on the selected DSC position.

Delete

>» 'MENU' + 'MENU' + "DSC" + 'ENTER' + "LOG" +

'ENTER' + "DELETE" + 'ENTER'
Deletes selected DSC position.

Delete All

>» 'MENU' + 'MENU' + "DSC" + 'ENTER' + "LOG" +

'ENTER' + "DELETE ALL" + 'ENTER'
Deletes all entties

Hide/Show
> 'MENU'+'MENU'+ "DSC" + '"ENTER' + "LOG" + "ENTER' + "HIDE/SHOW" +
'ENTER'

Allows hiding/showing the selected DSC position on the chart display.

Position Request/Distress Call
> 'MENU' + 'MENU' + "DSC" + 'ENTER' + "LOG" + '"ENTER' + "POSITION RE-
QUEST/DISTRESS CALL" + 'ENTER'

Shows Position Request/Distress Call page. When Position Request page is active
this message changes to Distress Call.

5.6.2.2 DSC DIRECTORY
> 'MENU' +'MENU' + "DSC" + 'ENTER' + "DIRECTORY" + 'ENTER'
Selects the DSC Directory page. From this page the user can assign the Ves-
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Gently push the C-CARD into one of the available slots (1); push the C-CARD
in as far as it will go, then move it to the right (2) to hold fixed into the slot (3).

Fig.2.6.1a - Inserting C-CARD (11)

The new cartography information will be displayed when you move the cursor
into an area covered by the new charts making pan or zoom operations. The boundary of
each chart digitized in the current C-CARD is shown as a rectangle.

2.6.2 REMOVING C-CARD

Press lightly the C-CARD you wish to remove (1) and move it to the left (2)
until you hear a click: the C-CARD will ejected out of the slot (3).

Fig.2.6.2 - Removing C-CARD

Note
C-MAP is continnonsly creating new charts and revising old ones. If you wish to receive information on
the newest availbale charts, yon can write for the catalog of available C-MAP C-CARD at your
dealer.

Note
To insert and remove the SD Card follow the C-CARD procedure describe above.
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2.7 VIDEO INPUT

By accessing this menu it is possible to see images on the chartplotter display
captured from an external video signal source, if connected to the chartplotter. Al- lows
the "picture-in-picture” functionality, so a Video Input image can be shown on a window and
placed over the other Video Input image at full screen.

» 'PAGE' + "VIDEO INPUT" + 'ENTER'
Note

If the Video Input signal is not detected (E.g. the video Camera is not connected to the Video Input
connector), the VIDEQ INPUT menu item must be grayed ont.

It is possible to select one of the following pages:

(1) Full Screen Video 1
Shows the image from the video camera 1 at full screen.

(2) Full Screen Video 2
Shows the image from the video camera 2 at full screen.

(3 Full Screen Video 1+ Video 2
Shows the image from the video camera 1 at full screen with the image from
the video camera 2 on a rectangular window placed on the upper-left corner
of the screen.

(@) Full Screen Video 2 + Video 1
Shows the image from the video camera 2 at full screen with the image from
the video camera 1 on a rectangular window placed on the upper-left corner
of the screen.

2.8 MENU OPTIONS

You may select how the chart plotter displays primary information (such as how

time is displayed) from the Functions Menu.
> 'MENU' + 'MENU'
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5.6.1 DISTRESS CALL AND POSITION REQUEST

During a distress situation, a vessel that is equipped with a DSC VHF radio and
connected to a GPS, has the capability to transmit a DSC Distress Call with GPS Position.

When the VHF radio receives a DSC Distress Call, the position information
of the vessel in distress is transferred to the chart plotter. The chart plotter logs the
Distress Call into the DSC Log and also marks the position of the vessel in distress
on the Chart page. A pop-up screen advises the user that a Distress Call has been
received. Within the pop-up screen it asks the user if he would like to view the call on
the Chart page or exit the pop-up screen. By selecting the item "VIEW ON CHART"
and press ENTER' two options ate shown:

+ GoTo Vessel

Activates the navigation to the Distress Call or Position Request icon. The
chart plotter changes the map scale to allow showing the Distress Call (or
Position Request) icon and the vessel’s icon simultaneously on the screen.
The chart plotter then verifies if there are obstructions (land or low water)
between the two positions. If obstructions are found the chart plotter shows
a pop-up screen saying that the navigation to the Distress Call cannot be set
automatically and the user must define a route to avoid the obstacles.

Stay on View

Exits the pop-up screen and remains on the selected map screen.

5.6.2 DSC MENU
To select the DSC menu:
» 'MENU' +'MENU' + "DSC" + 'ENTER'
The DSC menu is shown on the screen, the items are described in the following
paragraphs.

5.6.2.1 DSC LOG
>» 'MENU' + 'MENU' + "DSC" + 'ENTER' + "LOG" + 'ENTER'
Selecting Log shows the Distress Call Log page or Position Request Log page
(it depends which of the two was selected):
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The following selections are available:
Real Time View On
The data is shown (the area of the download) at the current date and time
(received from the GPS)
+ Real Time View Off
The Weather data is not displayed.
The layer displayed is the one selected into the previous menu item.

55.1.5 Type of Data
> 'MENU' +'MENU' + "C-WEATHER" +'ENTER' + "TYPE OF DATA" + 'ENTER'
Allows selecting the type of data, see the previous Fig. 5.5.

5.6 DSC

The DSC (Digital Selective Calling) is a method of establishing a VHF radio call; it is
used to announce urgent maritime safety information broadcasts. This sys- tem allows
mariners to instantly send Distress Call or/and Position Request to the other vessels
equipped with a DSC transceiver within range of the transmission.

The Distress Call, that allows to receive a position of the vessel in distress, and
the Position Request, a great feature for anyone wanting to know the location of another
vessel - for example you buddy that is catching fish, or finding the location of a person
you are cruising with, are performed by an external device, the DSC VHF radio. The chart
plotter interfaced with a DSC VHF radio prompts the user to see the GPS position of the
vessel in distress and also allows for easy navigation to the vessel.

The Distress Call and the Position Request icons that are displaying on the
screen, ate shown in the following table:

DESCRIPTION
Position Request icon |’P‘|
Distress Call icon @

Fig. 5.6 - Distress Call and Position Request icons

Note
The label can be the MMSI or the corresponding vessel's name. If in the DSC Directory the MMSI has
been associated to its relative vessel name, the vessel's name is shown in the label instead of the MMSI.
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2.9 DATA ENTRY

Information is keyed into the chart plotter when editing a Waypoint, enter- ing a
Route or using the Fix Correction functions. When the field is highlighted:

- Enter or edit data by pressing up/down Joystick to step through the avail- able
characters until the preferred character is displayed.

- Press right Joystick to move the cursor to the right.

- Use left Joystick to move the cursor to the left.

User Manual 27




France

Area of coverage of ttzerlapd g T Cursor is locked to the

downloaded data is
located by default with
its centre on the
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gray area.
Moving the cursor also
moves the gray area
allowing locating it
over the area where
the user wants to
download the Meteo
forecast.

Indicates the LAT/LON
position of the cursor

Fig.5.5.1.1 - Download Area

Press 'ENTER' to activate the C-Weather Download: the whole data pack- age
(see the previous "Weather data package" table) are downloaded. 'CLEAR' al- lows to
interrupt the data download. At the end of the operation press 'CLEAR' to close the
window.

5512 Copy from SD CARD

» 'MENU' + 'MENU' + "C-WEATHER" + 'ENTER' + "LOAD FROM FILE"
+'ENTER'

Allows the C-MAP WEATHER DATA loading from the SD CARD.

55.1.3  Weather Forecast
>» 'MENU'+'MENU'+ "C-WEATHER" + 'ENTER' + "FORECAST" + 'ENTER'
Allows selecting the Layer of specific weather data to be displayed on the
screen and to change date and time of the forecast preview.
The following functions are available:
Panning
Default usage of the cursor key is the normal panning function.
Zoom In/Out
Zoom in/out functions ate allowed as usual by using "ZOOM IN'/"ZOOM
OUT".
Set Date and Time
'ENTER' to modify date and time values.
Layer Selection
'PAGE' to cycle the weather layers.
Exit
'CLEAR' to close the weather prediction page.

55.1.4 Real Time View
» 'MENU'+'MENU'+ "C-WEATHER" + 'ENTER' + "REALTIME VIEW" + 'ENTER'
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Data Type Display

WIND (Speed & Dir) -oP
WAVE (Height & Dir) -1
TEMPERATURE (C°) 18°
HUMIDITY (%) 30
VISIBILITY (m) 20
WEATHER TYPE: Sun E0
WEATHER TYPE: Rain %
WEATHER TYPE: Fog -

WEATHER TYPE: Snow g
WEATHER TYPE: Clouds

WEATHER TYPE: Partly Cloudy
WEATHER TYPE: Thunderstorm

sy

el O

Fig.5.5 - Weather data package
Note

Please check with Iocal C-MAP Office for the actual C-WEATHER coverage of your area.

5.5.1 C-WEATHER SERVICE MENU

To select the menu:
>» 'MENU'+'MENU'+ "C-WEATHER" +'ENTER'

The C-Weather menu is shown on the screen, the items are desctibed in the
following paragraphs.

55.1.1 Download
> 'MENU'+ 'MENU' + "C-WEATHER" + 'ENTER' + "DOWNLOAD" + 'ENTER'
Allows to connect the software to the C-MAP weather server and to down-
load C-MAP weather data directly via C-COM.

Select Country to Call
Allows the selection of the country to call. The whole telephone number set is auto-
matically updated after every download.

SIM PIN
Allows inserting of the PIN of the SIM.

Download Area
Allows the weather download: a squared grey area, where the weather data will be
downloaded, is centered on cursor position. See the following picture.
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For the New User

In order to get started using your chart plotter, you must do the following
things:

1) Your chart plotter must have been installed properly according to the
installation instruction on Par. 0.2.

2) You must have performed the proper settings for use with your position-
ing instrument (see Par. 2.5) and inserting the C-CARD for navigating in area you
wish (see Par. 2.0).

3) You must have turned on the chart plotter and adjust the brightness and
contrast of the display (see Par. 2.2 and 2.3).

Once this is done, you can use your chatt plotter for navigation.

3.1 SCREEN DISPLAY CONFIGURATION

All pages (Chart page, Depth Graph pages, Navigation Data page, 3D Road Data
page, GPS Data page, GPS Status page) are shown on full screen window. In all data pages
(Navigation Data page, 3D Road Data page, GPS Data page, GPS Status page) five
Functions Keys are always shown on the bottom of the page in order to allow a quick way
to select the other pages.

Note

If the Fish Finder or Radar is connected, other pages are available. See the Fish Finder or Radar User
Manual for more information. 1f you have selected a 1Video Input (see Par. 2.7), in the Chart page a window
with the picture captured from the video signal source is shown.

3.1.1 FUNCTION KEYS CUSTOMIZATION

In all data pages the user can customize the Function Keys. Pressing and holding
down for 1 second the numeric key '1', '2', '3, '4', 5" it will be possible to

Uset Manual 29




assign a different selection to the relative Function Key.

Move the Joystick up/down to place the selector on the preferred item; move
the Joystick to the right ot press 'ENTER' to set the selected item; move the Joystick
to the left or press 'CLEAR' to close the pop-up window.

The possible choices are:

CHART (Chart and data page, see Par. 3.1.1.1)
NAV(iGATION) (Navigation Data page, see Par. 3.1.1.3)
ROAD (3D Road page, sce Par. 3.1.1.4)
STATUS (GPS Status page, see Par. 3.1.1.5)

GPS (GPS Data page, see Par. 3.1.1.6)
DEPTH 1 (Depth graph -small- page, see Par. 3.1.1.2)
DEPTH 2 (Depth graph Full page, see Par. 3.1.1.2)
VIDEO 1 (Full screen video image 1, see Par. 2.7)
VIDEO 2 (Full screen video image 2, see Par. 2.7)
MARK (allows to insert Mark, see Par.4.2.1)
EVENT (allows to insert Event, see Par.4.2.2)
WPT (allows to insert Waypoint, see Par.4.1.2)

TRACK ON/OFF  (allows Track On/Off, see Par.4.5)

The default settings for the function keys labels are: '1. Crarr', '2. Nav', 3. Roap),
'4, Status', '5. Grs',

Note
When the Fish Finder or Radar is connected, any soft key can be assigned any of the Fish Finder or
Radar pages. See the Fish Finder or Radar User Manual for more information.

3.11.1 Chart Display

It is very important to access the information you need as you need it and

understand what is displayed on the screen.
>» 'PAGE'+ "CHART DISPLAY" + 'ENTER'
ot
» '#.CuarT' (if it is present, where # is 1, 2, 3, 4 o1 5)
Shows the chart display and Text Area (if selected).

With the following procedure:
» 'MENU' +'MENU' + "DISPLAY" + '"ENTER' + "Data Window Mode" + '"ENTER'
itis possible to customize the Text Area layout among Full Screen, Vertical,
Text Area with 5 boxes and Text Area with 8 boxes (for Text Area with 5 boxes and
Text Area with 8 boxes you can select between Small or Large boxes size).
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5.4.3 TO SET THE CHART PLOTTER FOR RECEIVING AIS

Make sure that the AIS receiver is properly connected to the chart plotter. The
chart plotter reads the AIS NMEA message VMD, type 1, 2, 3 and 5.

Select the used setial port and transmission speed by following the procedure:
>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "PORT n INPUT" + 'ENTER' + "m" + 'ENTER'

Where:n = Port 1/Port 2/Port 3/Port 4/Port 5
m = NMEA-0183 4800-N81-N
NMEA-0183 38400-N81-N

according to the transmission speed of your AIS receiver.

5.4.4 QUICK INFO ON AIS TARGET

By placing the cursor over a AIS target icon, the following information is

displayed:
- Vessel Name

MMSI number

Radio Call Sign

SOG

COG

CPA and TCPA values

Note

The selected ALS target icon is surrounded by a square frame when user places the cursor over the icon.

5.5 C-WEATHER SERVICE

C-Weather Service is an innovative meteorological forecasting system with the
ability to visualize the weather forecast, overlaying it on cartography. The weather data is held
on C-MAP’s weather setver, which can be accessed via a C-COM modem connected to the
chart plotter or by using the C-MAP personal Suite (or the DPS - Dealer Programming
System) saving the weather data on a SD CARD. The weather data are overlaid on a map
page as layers. The Weather format data available are:
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5.4.2 AIS MENU

To configure the chart plotter to receive AIS data, follow the procedure:
» 'MENU' +'MENU' + "ADVANCED" + 'ENTER' + "AIS" + 'ENTER'
The AIS menu is shown on the screen, the items ate described in the follow-

ing paragraphs.

5421 Display
> 'MENU'+'MENU' + "ADVANCED" + 'ENTER' + "AIS" + 'ENTER'+ "DISPLAY"
+'ENTER'

Turns the display of AIS targets ovetlay on the cartography ON or OFF.
The default setting is ON.

54.2.2 Activation range
'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "AIS" + 'ENTER'+
"ACTIVATION RANGE" + 'ENTER'

Defines the range from the fix within which the AIS Target becomes active.
The values allowed are from 0.1 to 20 Nm. The default setting is 5 Nm.

54.2.3 CPA Alarm
» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "AIS" + 'ENTER'+
"CPA ALARM" + 'ENTER'

Turns ON or OFF the alarm. The default setting is ON.

5424 CPA Limit
» 'MENU'+'MENU'+"ADVANCED" +'ENTER' + "AIS" + 'ENTER'+ "CPALIMIT"
+'ENTER'

The values allowed are from 0.1 to 10 Nm. The default setting is 0.5 Nm.

5.4.25  TCPA Alarm
> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "AIS" + 'ENTER' +
"TCPA ALARM" + 'ENTER'

Turns ON or OFF the alarm. The default setting is ON.

5.4.2.6  TCPA Limit
> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "AIS" + 'ENTER'+
"TCPA LIMIT" + 'ENTER'

The values allowed are from 1 to 30 min. The default setting is 10 min.
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It is also possible to edit fields shown in every screen configuration. Edit
mode is activated directly from the chart display pressing 'MENU' for 3 seconds.

Once the Edit mode is active, the first box with the label turns in reverse video
screen. The user can choose the active box by moving the Joystick left or right.

Pressing 'ENTER' the user can choose the data to be shown on the selected
field by moving through the selections and pressing 'ENTER' again.

Se-21.268N [ oestT |
. 398

204 -08. 73I9W

Fig.3.1.1.1 - Text Area layout
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T1a Time To Go (Fix o Destination] Fix Status
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BRG Bearing (Fix lo Destination)” L . .
=06 Speed Over Ground -\ this icon is shown if
coa Course Over Ground fix is received
TCON I
i::LE ghart %_calek c -@MIS icon is shown if
ross Track Error ) :
VMG Velocity Mode Good* fix is not received
DEPTH Depth from Transducer 3
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TEMP . \E"\faler Temperature fix a Differential GPS
DATE ate H i
FrE 7 TIRER Tine signal is received
SET Direction of the water surface -Haasthis icon is shown if
DRIFT Horizontal velocity of the water surface .
EBL & ¥RM |EBL and VRM information \ WAAS. COH’BC.UGS
TRACK Track On/Of and available Tragk pois IS recelve:
Fig- 51 1°H8" Bdlit mode
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Note
(%) It will be shown only if the Destination is present.

Once 'ENTER ' is pressed the data type is set. The selection window is closed and
the Text Area changes according to the selected data type. Press 'CLEAR' to exit the Edit
mode.

Note
The Display Menu can be selected only from the Chart Display page and the Depth Graph page in_split mode.

3.1.1.2 Depth Graph pages
The Depth graph can be shown in two different modes. To select the Depth
Graph in split mode:
>» 'PAGE' + "DEPTH GRAPH" + 'ENTER'

or
> '#.Depru ' (if it is present, where # is 1, 2, 3, 4 ot 5)

Se-21.21eN
204-08. 739K
T Cme N

i - v

Fig.3.1.1.2 - The Depth Graph in split mode

Otherwise selecting the Depth graph displayed at full screen:
> 'PAGE' + "DEPTH GRAPH FULL" + 'ENTER'

or
> '#.Depru 2' (if it is present, where # is 1, 2, 3, 4 or 5)
Se-=1.185M DEST e 28:47)
R4 B8. TI9 [ 2.:sf™ 185°

Fig.3.1.1.2a - The Depth Graph Full
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+ Name
Name of ship, 20 characters.
- MMSI
Maritime Mobile Service Identity.
+ MMSI number
A unique 9 digit number that is assigned to a DSC radio station. It primarily
registers the boat information in the U.S. Coast Guard’s national distress
database for use in emergency situations.
+ Active Target
Target located within the Activation Range. Active target is represented by
oriented triangle with COG and Heading vectors. Rate of turn may also be
displayed.
+ Dangerous Target
Target detected by CPA or TCPA Alarm. Dangerous target is Active Target
by definition. For better visibility Dangerous Target symbol is flashing.
+ Sleeping Target
Target located outside the Activation Range. Sleeping target is represented by
a small orented triangle.
+ Lost Target
When the AIS info is not received from that vessel for 3.5 minutes. The
presentation will be a flashing black triangle with a cross through.
+ Activation Range
Range around your boat where targets become active. AIS target become
active within this range. Activation Range should be greater than CPA Limit
by definition.
Note
A target is removed from the screen if data is not received for 10 minutes. The
maxcimum number of tracked targets is 100.
Depending on the scale the presentation of the targets change to remove clutter on the screen.

This information is updated every 3 seconds to 6 minutes depending on speed and rate of turn, enabling
the track of the vessels in range to be plotted.

TARGET STATUS DESCRIPTION SYMBOL
ACTIVE TARGET Target located within the Activation Range. A
Target detected by CPA or TCPA Alarm. °n
DANGEROUS TARGET Dangerous Target is Active Target by definition. Flashing
SLEEPING TARGET Target located outside the Activation Range. A
LOST TARGET Ais info is not received from that vessel for 3.5 minutes. A

Fig. 5.4.1 - AIS Symbols
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information from the ship automatically, requiting a minimum of involvement of ship’s
personnel, and should have a high level of availability. AIS transponders in- stalled on
IMO vessels use VHF frequencies to:

+ Transmit details of their own vessel
+ Receive details from other vessels or navigation aids within VHF range.

Information being transmitted from vessels over 300 tons that, due to recent

worldwide legislation, are required to fit Class “A” AIS transponders.
Connecting to the chart plotter an AIS receiver (please contact your local
dealer), vessels with AIS transponder within VHF range are displayed on screen

giving the skipper or navigator a visual interpretation of the data of nearby vessels. This
improves safety, and specifically for collision avoidance reasons.

5.4.1 AIS SYSTEM DEFINITIONS

. Target
It is a vessel equipped with AIS. Information about the targets is being re-
ceived by AIS Receiver and displayed on the screen.

. CPA
Closest Point of Approach is the closest distance that will be achieved be-
tween your vessel and the tracked target, based on your vessel’s speed and
direction and the target’s speed and direction.

. CPA Limit
This is the distance from your vessel that a target may reach before a target is
deemed a threat.

- CPA Alarm
Occurs if CPA is less or equal to CPA Limit. This test is done for active
targets only.

. TCPA
Time to closest Point of Approach is the time remaining until the CPA will
occut,

. TCPA Limit
This is the time remaining before the CPA is reached.

- TCPA Alarm
Occurs if TCPA is less or equal to TCPA Limit. This test is done for active
targets only and if CPA value is less or equal to CPA Limit.

+ Radio Call Sign
International call sign assigned to vessel, often used on voice radio.
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3.1.1.3 Navigation Data page
The Navigation Data page shows information about the most relevant navi-

gation information, the status of the received signal and ship's coordinates. It is pos- sible
to customize the information contained in the page selecting the Nav Display menu (see
Par. 5.2).

» 'PAGE' + "NAVIGATION DATA" +'ENTER'
ot

> '#.Nav' (if it is present, where #is 1,2, 3,4 ot 5)

Fix Coordinates — [E— oy Date and
Fix &ood | B | uTorss a3 u‘l UTC (U) or Local (L) Time
Fix Status To DEST <« |
Alphanumeric identifier
Speed Over Ground of the Target if set
506 3-@1{(5 co6 1?50 H‘
Distance ost 2. 187 1w cs 1857 < Course Over Ground
Cross Track Eror = RO.00 = R 010" 5
Course To Steer
col P LB.2 f RB.Z Nm
(Course Deviation Indicator) + o ™ » - & 3w 2= Steering

Fig. 3.1.1.3 - Navigation Data Page

3.1.1.4 Road page

The 3D Road Data Page shows in graphic mode navigation data. It is pos-
sible to customize the information contained in the page selecting the Nav Display
menu (see Par. 5.2).

> 'PAGE' + "3D ROAD" + 'ENTER'
ot
> '#.Roap' (if it is present, whete #is 1,2, 3, 4 or 5)

Speed Over Ground Course Over Ground
I .. ws 175° .4
Distance T } pst 2. 138 s 1895° » -« Course To Steer

—— e s R 010° < Steering

Alphanumeric identifier
of the Target if set

CDI
{Course Deviation Indicator)

CDI
(Course Deviation Indicator)

Fig.3.1.1.4 - 3D Road Data Page
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3.1.15 GPS Status page
The GPS Status page shows in graphic mode GPS data.
» 'PAGE' + "GPS STATUS" + 'ENTER'
ot
> '#.Status' (if it is present, where #is 1,2, 3, 4 ot 5)

Fix Status Fix coordinates A Date and
UTC (U) or Lacal (L) time

58°28. STSH BZ'@G’EIA
B04°68. 73 18:37:51 U

Used Satellite Fix Good = 07 azimuth

120° azimuth
= 0° elevation

C = 45° elevation
D =907 elevation

A
B
E
Bars to indicate S/N Ratio

~Tracked, but not used,

Speed Over Ground Satellite
18 38 15 25 2 29 0z -] o5 13 T
S : Course Over Ground
Course Over Ground >§§: e G o ;iz; | B
o] im ] [l rom] [ow ] Horizontal dilution of precision
Altitude Vertical dilution of precision

Fig. 3.1.1.5 - GPS Status Page

On the right side of the screen (see Fig. 3.1.1.5), there is a polar representa- tion
of the azimuth and elevation of each satellites. The circles contain a number indicating the
PRN of the satellite and they are filled when they are used for the fix solution. On the left
side there are histograms indicating the S/N ratio (SNR). The bar is filled when the
satellite is used for fix solution. When a valid fix is received, the Lat/Lon, Date, Time,
HDOP, VDOP, ALT, COG, SOG are shown in the page.

3.1.16 GPS Data page

The GPS Data page shows the GPS data.
>» 'PAGE' + "GPS DATA" + 'ENTER'

or
> '#.Gps' (if itis present, where #is 1,2, 3,4 or 5)
Speed Over Ground Fix Coordinates
43°28.362N <
016°10. 137E
‘E cos o Course Over Ground
w 3.8 7168
w Fix Good 0/B/0
W5 1334 18:28:24 U Date and
Fix Status [somr | [ew | [osm] [eomms] [ s | UTC (U} or Local (L) Time
Fig. 3.1.1.6 - GPSData Page
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You can select the length and its angle is 30 degrees. The Grounding Alarm is switched
Off by default after a Master Reset.

5.3.4.11  Grounding Depth Limit
» 'MENU'+'MENU' +"ALARMS" +'ENTER' +"Grounding Depth Limit" +'ENTER'
The user can enter the minimum depth.

5.3.4.12  Grounding Alarm Range

> 'MENU' + 'MENU' + "ALARMS" + 'ENTER' + "Grounding Alarm Range" +
'ENTER'

Allows setting the length of the sector to be detected among 0.25, 0.5, 1.0
Nm. The default setting is 0.25 Nm. When any of the searched objects is found in the
scanned area, a tick marker is printed on the relative box in the Grounding Alarm
Report page (see Par. 5.2.8) to identify which dangerous objects have been currently
detected.

5.3.4.13  Grounding Alarm Report

> 'MENU' + 'MENU' + "ALARMS" + 'ENTER' + "Grounding Alarm Report"
+'ENTER'

To display the report of the dangerous objects currently detected. When any
of the searched objects is found in the scanned area, a tick marker is printed on the
relative box to identify which dangerous objects have been currently detected. Once
the alarm condition is no longer present, the relative tick marker is removed.

Note

The alarm "No data available" is shown when no specific cartographic data are found on the C-CARD
or when no C-CARD is inserted.

5.3.4.14  External Alarm
>» 'MENU' +'MENU' + "ALARMS" +'ENTER' + "External Alarm" +'ENTER'
When any alarm condition occurs the pin is switched from High Impedance
to ground. This signal can be used by an external device (as a hooter or buzzer).You
can enable (On) or disable (Off) the External Alarm. The default setting is On.

5.4 AIS MENU

AIS is an Automatic Identification System. It has been introduced to im- prove
the safety of navigation by assisting in the efficient operation of ship-to ship, ship
reporting and VTS applications. The system should enable operators to obtain
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box will appear with 00. Using the Joystick select the number preferred and press
'ENTER'. The default setting is Off (00).

5.3.4.5 Depth Alarm
> 'MENU' +'MENU' + "ALARMS" +'ENTER' + "Depth Alarm" + '"ENTER'
Specifies the depth or disables the Depth Alarm. After pressing 'TENTER'a
box will appear with 00. Using the Joystick select the number preferred and press
'ENTER'. The default setting is Off (00).

5.3.4.6 Heading Alarm
>» 'MENU' + 'MENU' + "ALARMS" + 'ENTER' + "Heading Alarm" + 'ENTER'
You can enable (On) or disable (Off) the Heading Alarm. The default setting
is Off.

5.3.4.7  Timer Alarm
>» 'MENU' +'MENU' + "ALARMS" +'ENTER' + "Timer Alarm" + 'ENTER'
Starts (On) or Stops (Off) the Timer Alarm counter. The Timer Alarm is
activated when the defined time is expired.

53.4.8  Timer Value
>» 'MENU'+'MENU' + "ALARMS" +'ENTER' + "Timer Value" + 'ENTER'
Enter the Timer Value (Hours Minutes Seconds Range 00:00:01 - 23:59:39).

5.3.4.9 Timer Direction
>» 'MENU' +'MENU' + "ALARMS" +'ENTER' + "Timer Direction" + '"ENTER'
Set the Timer Ditection UP or DOWN: when Timer Ditection is set UP,
the timer start from zero and increases it's value; the alarm is activated when the
timer reaches the Timer Value entered by the user. When Timer Direction is set
DOWN, the count-down statts from the value set by the user and decreases it's
value. The Alarm is activated when the Timer value goes to zero.

5.3.4.10 Grounding Alarm
> 'MENU' +'MENU'+ "ALARMS" + 'ENTER' + "Grounding Alarm" + 'ENTER'

To verify potential danger to navigation such as shallow water (depth areas),

intertidal areas, land, rocks, obstructions and shoreline constructions. The maps are

scanned every 10 seconds. If any of the above objects are found, the chart plotter

notifies the danger on a dedicated warning message box. The active "Grounding

Alarms" are shown in the Grounding Alarm Report page. The chart plotter scans a

sector in front of the boat. The direction is determined by the current boat heading.
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3.2 GENERAL MENU

The General Menu provides access to the set up functions. Here you can choose
the language you want (see Par. 2.4), the measure units, the date and time settings, enable

or disable the Keypad Beep (see Par. 1.2) and select the Cursor Speed.
» 'MENU'+'MENU' + "GENERAL" + 'ENTER'

3.2.1 UNITS SELECTION

Allows to select the preferred unit for Distance, Speed, Depth and Altitude
(altitude of GPS Antenna on the medium sea level).

Distance & Speed Units: Nm(Nautical Miles) & Kts(knots) / Sm(statute miles) &
Mph(miles per hour) /Km(chilometres) & Kph(chilometres per hour). The default setting

is Nm & Kts.
» 'MENU' + 'MENU' + "GENERAL" + 'ENTER' + "Dist&Speed Units" + 'ENTER'

Depth Unit: Ft(Feet)/FM(Fathoms)/Mt(Meters). The default setting is Ft.
>» 'MENU'+'MENU' + "GENERAL" + 'ENTER' + "Depth Unit" + '"ENTER'

Altitude Unit: Ft(Feet)/FL(Flight Level)/Mt(Meters). The default setting is Ft.
» 'MENU' +'MENU' + "GENERAL" +'ENTER' + "Altitude Unit" + "ENTER'

Temperatute Unit: °C/°F. The default setting is °C.
» 'MENU' + 'MENU' + "GENERAL" + 'ENTER' + "Temperature Unit" + 'ENTER'

3.2.2 TIME & DATE SETTING

Allows to select the preferred time and date.

Time Reference: Sets UTC or Local Time. The default setting is UTC.
» 'MENU' + 'MENU' + "GENERAL" + 'ENTER' + "Time Reference" + '"ENTER'

Time Format: Sets you preferred time between 12 hour and 24 hour. The default

setting is 24 hour.
» 'MENU'+'MENU' + "GENERAL" +'ENTER' + "Time Format" + '"ENTER'

Date Format: Sets you preferred date between MM-DD-YY (month-day-year) and

DD-MM-YY (day-month-year). The default setting is MM-DD-YY.
» 'MENU' +'MENU' + "GENERAL" +'ENTER' + "Date Format" + '"ENTER'
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3.2.3 CURSOR SPEED

Allows to select the preferred Cursor Speed among Low, Medium and High in

Chart or into a Menu:
>» 'MENU' +'MENU' + "GENERAL" + 'ENTER' + "Cursor Speed" + 'ENTER'

3.2.4 NAV AIDS PRESENTATION

Allows to set the Nav Aids presentation as US ot INTERNATIONAL. The
default setting is INTERNATIONAL. When selected it affects Lights, Signals, Buoys
& Beacons display.

- INT(International): Draws Nav-Aids using international symbology. All
components of Complex Objects are shown.

- US: Draw Nav-Aids using NOAA symbology. All components of Com-
plex Objects are shown.

» 'MENU'+'MENU' + "GENERAL" +'ENTER' + "Nav Aids Presentation" + "ENTER'

3.3 NAVIGATING TO A SINGLE DESTINATION

3.3.1 DISTANCE AND BEARING TO TARGET

Once you have positioned the cursor on your prefetred location press'GOTO!.
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Fig. 3.3.1 - Navigation to a single destination
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Enables (On)/disables (Off) the cursor control. The default setting is Off.

5.3.35 Simulation Mode

Once the settings are selected, turn on the Simulator:

>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +

'ENTER' + "Simulation Mode" + '"ENTER' + "On" + 'ENTER'
To turn On the Simulation select Off. The default setting is Off.

5.3.4 ALARMS MENU

The chart plotter provides alarm settings for various functions. Here you can set

the system for your navigational requirements.
» 'MENU' +'MENU' + "ALARMS" +'ENTER'

5.34.1 Auto Off
>» 'MENU' +'MENU' + "ALARMS" + 'ENTER' + "Auto Off" + 'ENTER'
You can enable (On) or disable (Off) the automatic shutdown of the alarms
when the alarm condition disappears. The default setting is On.

5.3.4.2 Arrival Alarm
» 'MENU'+'MENU' +"ALARMS" + 'ENTER' + "Attival Alarm" + '"ENTER'
Specifies the radius of a circle around the Waypoint of a Route: when your
vessel reaches this circle the alarm sounds. After pressing 'ENTER'a box will appeat
with Off (00). Using the Jopstick select the number preferred and press 'ENTER'.
The default setting is 1.00 Nm.

5.34.3 XTE Alarm
» 'MENU'+ 'MENU' + "ALARMS" + 'ENTER' + "XTE Alarm" + '"ENTER'

Specifies the distance your Cross Track Error (XTE) can vary before the
sound of an alarm or disables the XTE Alarm (Off). After pressing 'ENTER'a box
will appear with 00. Using the Joystick select the number preferted and press 'ENTER'.
The default setting is Off (00).

5.3.4.4  Anchor Alarm
» 'MENU' +'MENU'+ "ALARMS" + 'ENTER' + "Anchor Alarm" + 'ENTER'
This function allows inserting of the limit of anchor dragging: beyond that,
the alarm is activated. The chart plotter computes the distance between the current
GPS position and the GPS position saved at the activation of the anchor alarm in the
menu. If the computed distance exceeds the value set in the menu, the chart plotter
shows the alarm message and starts the acoustic alarm. After pressing 'ENTER' a
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5.3.2.9 Calibrate Compass

>» 'MENU'+'MENU' + "ADVANCED" +'ENTER' + "FIX & COMPASS" +'ENTER'
+ "CALIBRATE COMPASS" + 'ENTER'

The variation table is used to match magnetic value readout on the chart
plotter comparable with the value given by the compass of the boat. In other words,
since the compass of the boat must be compensated (due to the iron masses, ...), we
use the same values given by the chart plotter. This means that, for example, if the
BRG to the next Waypoint readout in the chart plotter display is "X" Mag degtee, if
you steer the boat reading "X" Mag degree from the compass, you are driving well
toward the next Waypoint.

5.3.3 SIMULATION MENU

>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +
'ENTER'

The built-in Simulator function allows you to become proficient in the use
of the chart plotter. No current position fix is required because the chart plotter
simulates position data internally.

53.3.1 Speed

> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +
'ENTER' + "Speed" + 'ENTER'

To start the simulator you can insert the Speed value. Using the Joystick
select the preferred Speed and press 'ENTER'. The default setting is 01.0 Kts.

5.3.3.2 Heading

> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +
'ENTER' + "Heading" + 'ENTER'

To start the simulator you can insert the Heading value. Using the Joystick
select the preferred Heading and press 'ENTER'. The default setting is 000° M.

5.3.3.3 Date and Time

>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +
'ENTER' + "Date" + 'ENTER'

>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +
'ENTER' + "Time" + 'ENTER'
Using the Joystick insert the preferred Date and Time and press 'ENTER'.

5.3.34 Cursor Control

> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "SIMULATION MODE" +
'ENTER' + "Cursor Control" + '"ENTER'
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On the screen is shown a dotted line connecting the Target with the ship's
position. When the Target is placed, all navigation data are referred to this Target.

3.3.2 TIMETO GO

When the Target is set the TTG value can be displayed in the Text Area (see Par.
3.1.1). Otherwise select the 3D Road Page (see Par. 3.1.1.4) where you can read TTG
value (if it is selected):
> 'PAGE' + "3D ROAD" + 'ENTER'
ot

> '#. Roap' (if it is present, where # is 1, 2, 3, 4 ot 5)

3.3.3 DELETING TARGET

Place cursor on Target icon then press '1. Stor'. A window appeats to con- firm
the stop of the navigation: press 'l. CONFIRM' and the symbol identifies Target disappeats
from the screen.

3.4 NAVIGATION ON A ROUTE

Sometimes it is preferable to define a series of locations, called Waypoints, in a
sequence called a Route and navigate following a Route towards its end point.

3.4.1 ADDING WAYPOINT
To create a Waypoint place the cursor on position you want and then:
>» 'ENTER' + "WAYPOINT" + 'ENTER'
of
> '#.Wer' (if it is present, where #is 1,2, 3,4 ot 5)
The Waypoint appears on the screen and this becomes the first point on
your first Route. An info window containing Route number, data and time, Way-
point name, symbol and Latitude/Longitude is shown.

3.4.2 CREATING A ROUTE

Repeat the "Adding Waypoint" procedure desctibed in the previous Par.
3.4.1. The sequence of moving the cursor and pressing 'ENTER' is continued to
create the Route, until you have reached the last Waypoint, your final destination.
Segments connecting the Waypoints are shown and the starting point is identified
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Corrects fixes from the positioning instrument. By placing the cursor on the ship's

by a circle surrounding the first Waypoint of the Route:
real position and selecting this option, the error is calculated and internally memorized for
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5.3.2.3 Correction Offset

>» 'MENU'+'MENU' + "ADVANCED" +'ENTER' + "FIX & COMPASS" + 'ENTER'
+ "Correction Offset" + '"ENTER'

Manual cortection of fix position.

5.3.24 Static Navigation
> 'MENU'+'MENU' + "ADVANCED" +'ENTER' + "FIX & COMPASS" + 'ENTER'
+ "Static Navigation" + 'ENTER'

Sets up a threshold for the speed. When the speed received from the position-
ing device is under that threshold, the chart plotter displays zero speed. The default
value is 0.1 Knots.

.... 5.3.25 Position Filter

Eonmm >» 'MENU'+'MENU' +"ADVANCED" +'ENTER' + "FIX & COMPASS" + 'ENTER'
+ "Position Filter" + '"ENTER'

Turns On/Off the Position Filter. In case of a jittering fix this option makes
the ship' position more stable and the track smoother. The default setting is Off.

3.4.3 DELETING WAYPOINT _
Place the cursor on the Waypoint to be deleted: 5.3.2.6 Speed Filter

_ - . >» 'MENU'+'MENU'+"ADVANCED" + 'ENTER' + "FIX & COMPASS" +'ENTER'
Se- 6. 119M MOB i —i—- + "Speed Filtet" + 'ENTER'

eOS”"30. 4=21 tn” 2.3%|" 7 Turns On/Off the Speed Filter. When it is On, you can filter the speed of
the ship, to optimize it. The default setting is Off.

510000

5.3.2.7 Bearing
» 'MENU'+'MENU' + "ADVANCED" +'ENTER' + "FIX & COMPASS" +'ENTER'
+ "Bearing" + 'ENTER'
Selects either degrees magnetic, Auto Mag, or True. If magnetic readings are
selected the variation is computed automatically for every zone as soon as the chart
is displayed. The default setting is Auto Mag.
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o T [ =N 5.3.2.8  Magnetic Variation

orssomn | F ] ] » 'MENU' +'MENU' + "ADVANCED" +'ENTER' + "FIX & COMPASS" + 'ENTER'
T2 £2%5 I i ‘ ] + "Magnetic Variation" + "ENTER'

L Itis possible to calculate the Magnetic Variation in an Automatic or manual

mode, by inserting the step for calculation of Magnetic Variation. The default set-
ting is Automatic.
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Fig. 3.4.3 - Deleting Waypoint
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or Radar Plotting); SD (Sounder Depth). The selected Talker ID is applied to all

sentences sent by the chart plotter from all Ports.
> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "NMEA-0183 Output Talker ID" + 'ENTER'

53.15 Cable Wiring Pages

Shows a window containing the inteface cable wiring. See Par. 6.3 and 6.4.
'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "Cable Wiring" + 'ENTER' + "Power I/O" + 'ENTER'

'MENU' + 'MENU' + "ADVANCED" +'ENTER' + "INPUT/OUTPUT" +'ENTER'
+ "Cable Witing" + 'ENTER' + "Port 1 - GPS Sensor" + 'ENTER'

'MENU' + 'MENU' + "ADVANCED" +'ENTER' + "INPUT/OUTPUT" +'ENTER'
+ "Cable Witing" + 'ENTER' + "Port 2 - GPS Sensot" + 'ENTER'

5.3.1.6 Send/Receive Routes and Marks

Sets the desired port used for transferring User Points and Routes functions:
>» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "SEND/RECEIVE ROUTES AND MARKS" + 'ENTER'

5.3.1.7 External Signal

Sets the External Output. Then choose your preferred setting among External
Alarm (when activated, this pin goes to GND level. It is used to command an external
buzzer), Radar Power On (it is command switch for the Radar. It must be used in
conjunction with the Radar Junction box device) and Off.

> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "EXTERNAL SIGNAL" + 'ENTER'

5.3.2 FIX & COMPASS MENU

> 'MENU' +'MENU' + "ADVANCED" +'ENTER' + "FIX & COMPASS" +'ENTER'
The Fix & Comapss sub-menu contains options relating to GPS data input

and display.

5.3.2.1 Fix Correction

>» 'MENU'+'MENU' +"ADVANCED" +'ENTER' + "FIX & COMPASS" +'ENTER'
+ "Fix cotrection" + '"ENTER'

Tutns On/Off the Cottection from the positioning system. If the new Cot-
rection is calculated, but the Correction is not enabled, the ship's position is not
changed. The default setting is Off.

5.3.2.2 Compute Correction

> 'MENU'+'MENU' + "ADVANCED" +'ENTER' +"FIX & COMPASS" +'ENTER'
+ "Compute correction” + '"ENTER'
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Press '2. DELETE'. A window is opened to advise that Waypoint is being used in a
Route: press '1. Conrry' (‘2. Cancer' otherwise). The Waypoint is deleted and a new line
between previous and next Waypoint is shown. The deleted Waypoint remains shaded

until the screen is redrawn.

3.4.4 DISTANCE AND BEARING TO TARGET

Once you have positioned the cursor on the preferred starting Waypoint (it could
be the first Waypoint of the Route or another one) press 'GOTO". A circle surrounds the
Waypoint symbol. A dotted line is shown, connecting the Target with the ship's position.
When the Target is placed, all navigation data are referred to this Target. The destination
will automatically switch to the next Waypoint on the Route when you reach or pass the
present destination.

3.4.5 TIMETO GO

When the Target is set the TTG value can be displayed in the Text Area (see Par.
3.1.1). Otherwise select the 3D Road Page (see Par. 3.1.1.4) whete you can read TTG
value (if it is selected):
» 'PAGE' + "3D ROAD" + 'ENTER'
ot
» '#.Roap' (if it is present, whete # is 1, 2, 3, 4 ot 5)

3.4.6 DELETING TARGET

Place cursor on Target icon then press '1. SToP'. A window appears to con- firm
the stop of the navigation: press '1. CONFIRM' and the symbol identifies Target disappears
from the screen.

3.5 C-MAP NT MAX INFORMATION

MAX is 2 major evolution of the NT/NT" product technology. Key points ate:

New Data Features

- Tides and Currents (intuitive arrows show direction and strength)
- World Background Charts with terrestrial data

- Value Added Data (Pictures and Diagrams, Land Data)

- Enhanced Port Info
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New Presentation Features

- Clear View (advanced legibility techniques providing more chart data on the screen)
- Clear Info (sophisticated "Human Disctionary" to translate Nav-Aid abbreviations
found on paper cahrts)

- Dynamic Fonts and Symbols

- Dynamic Nav-Aids (an innovative and dynamic presentation mode)

- Flexi-Zoom (increased Under and Over Zoom between chart levels, resulting in
optimal scale display for any situation)

- Dynamic Elevation Data (optimised palettes for chart plotters with 256 or more
colors; inludes new NOAA palette for US market)

- Perspective View ("Real World" perspective view of the chart, updated realtime
during navigation)

MAXand NT/NT* C-CARD coexistence

- When NT* data and MAX data cover different areas, the chart plotter gets data from
both charts (depending on the current position).

- When NT" data and MAX data cover the same area, the chart plotter gets data only

from MAX chatt.

This is for the WorldWide Background as well.

3.5.1 MAP MENU

35.1.1 Zoom Type
» 'MENU' +" Zoom Type" + 'ENTER'

This feature allows more expansions or compression of the chart scale while
zooming in or out.

Zoom Mode has two options; STANDARD (default) or FLEXI-ZOOM.
When in FLEXI-ZOOM mode, a shott "ZOOM..." push causes a change of chart,
whilst a long "ZOOM..." push (press and hold) causes a pop-up window to be dis-
played on a corner of the screen. The window shows the current Zoom Factor.

By pressing "ZOOM IN'/"ZOOM OUT' the map is expanded ot compressed
according to the zoom factor selected.

The Window is automatically closed if "ZOOM..." is not pressed for 2 sec-
onds and the selected zoom factor will be used at the next zoom in/out.

35.1.2 Fonts & Symbols
> 'MENU' + "Fonts & Symbols" + 'ENTER'
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WARNING m
After every software upgrade the RAM is cleared and the chart plotter re starts with the usnal defanlt
settings. Please go to the Input/ ontput menu and set the proper input format once again.

53.1.1 Port 1/Port 2/Port 3/Port 4/Port 5 Input
Disables (selecting Off) or sets the format for the navigation data input serial
Portl/2/3/4/5. For example to set the Port as NMEA-0183 (4800 Baud Rate, Parity
None, 8 Bits Number, 1 Stop Bit and Normal Polarity) you must select 4800-N81-N. The
available choice is among (1200-N81-N), (4800-NSI-N), (4800-N82-N), (9600- O81-N),
(9600-N81-N), C-COM (*). The default setting is (4800-N81-N).
> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "Port 1/Port 2/ Port 3/Port 4/Port 5 Input" + 'ENTER'
Choose your preferred setting and press ENTER' to confirm.
Note &)
The option C-COM defines on which Port (both Input and Ontput) the C-COM modem is connected. It is
important to remark that this setting affects the Input and the Output of the selected Port. C-COM can
only be set on one Port at time. If C-COM was already assigned to a Port and the user tries to set the C-
COM to another Port, the chart plotter will
show a message that warns the user about the current settings and asks if the new settings
must overwrite the previous ones.

53.1.2 Port 1/Port 2/Port 3/Port 4/Port 5 Output
Disables (Off) or sets the interface as NMEA 0183, NMEA 0180, NMEA

0180/CDX.. The default setting is 0183.
>» 'MENU'+'MENU'+"ADVANCED" + 'ENTER' + "INPUT/OUTPUT" + 'ENTER'
+ "Port 1/Port 2/ Port 3/Pott 4/Port 5 Output" + 'ENTER'

53.1.3 Port 1/Port 2/Port 3/Port 4/Port 5 NMEA Output

The chart plotter allows customizing the NMEA-0183 sentence transmitted on
each port. Each port can transmit a different set of sentences among: GLL, VIG, BOD,
XTE, BWC, RMA, RMB, RMC, APB, WCV, GGA, HSC, HDG, MWV. The default
setting is GLL, VTG, XTE, RMB, RMC, APB, MWV On and BOD, BWC, RMA, WCV,
GGA, HSC, HDG Oft.

> 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "INPUT/OUTPUT" +
'ENTER' + "Port 1/Port 2/Port 3/Port 4/Port 5 NMEA Output" + 'ENTER'

5.3.14 NMEA-0183 Output Talker 1D

The Talker Id is the 2 characters following the “$” char (Start of sentence) in a
NMEA-0183 sentence that identifies the type of instrument that sends the string. The
chart plotter allows selecting one of the following Talker identifier: II (Inte- grated

Instrument); GP (GPS); EC (Electronic Chart System-ECS); RA (Radar and/
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possible to display this menu only if the Navigation Data page or the 3D Road page has
been selected; so firstly select one of this pages, for example Navigation Data page:
> 'PAGE' + "NAVIGATION DATA" + 'ENTER'

or
> '#.Nav' (if it is present, whete #is 1,2, 3,4 ot 5)
and then:
» 'MENU' + 'MENU' + "NAV DISPLAY" + 'ENTER'

5.2.1 CDI SCALE

» 'PAGE' + "NAVIGATION DATA" + 'ENTER' then:
» 'MENU' +'MENU' + "NAV DISPLAY" +'ENTER' + "CDI Scale" + 'ENTER'

Select your preferred CDI (Course Deviation Indicator) Scale among 0.2,
0.5,1.0,2.0, 4.0, 10.0 Nm by using the [oystick and then press 'ENTER'. The default
setting is 0.2 Nm.

5.2.2 NAVIGATION PAGE

» 'PAGE' + "NAVIGATION DATA" + 'ENTER' then:
>» 'MENU' +'MENU' + "NAV DISPLAY" + 'ENTER' + "Navigation Page" + '"ENTER'

A new window appears with six items. Using the Joysfick select the item you
want to change and press 'ENTER": another window appears, use the Joystick to
select the preferred data to display in the Navigation Data page and in 3D Road page
among BRG (Bearing), SOG (Speed Over Ground), COG (Course Over Ground),
STR (Steering), CTS (Course To Steer), TRN (Turning), DTG (Distance To Go),
VMG (Velocity May Good), SOA (Speed Of Advance), XTE (Cross Track Error),
DRF (Drift), SET, DPT (Depth), TEMP (Water Temperature). When finished press
'ENTER'. The default setting is SOG, COG, DTG, CTS, XTE, STR.

5.3 ADVANCED MENU

The Advanced options are arranged in sub-menus. For example, all options that

relate to the Fix functions are in Fix & Compass sub-menu.
>» 'MENU' +'MENU' + "ADVANCED" + 'ENTER'

5.3.1 INPUT/OUTPUT MENU

> 'MENU'+'MENU' +"ADVANCED" +'ENTER' +"INPUT/OUTPUT" +'ENTER'
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On MAX charts it is possible to set the size of all names and symbols drawn on the

charts, selecting between Normal size (the regular characters size) and Large size.
Tq R

Needles Chann

&

Fig.3.5.1.2 - Example of Normal size (on the left side) and Large side (on the right side) settings

3513 Perspective View
» 'MENU' + "Perspective View" + 'ENTER'

Chart data may be projected in perspective mode during navigation. This
function allows setting the panoramic View of the chart.
As the upper side of the map is more compressed than the lower side, a wider map
area is visible. The perspective view allows showing more chart information immedi-
ately ahead and around the cursor.

Fig. 3.5.1.3 - Perspective View

35.1.4 Dynamic Nav-Aids
» 'MENU' + "Dynamic Nav-Aids" + 'ENTER'

This function allows settings blinking lights on Nav-Aids. The blink period and
color of each Nav-aid is read from the Nav-Aid attributes available on the data cartridge.
When the ship is inside the Nav-Aid nominal range, the light of the Nav- Aid will start
blinking.

g\X/hen Dynamic Nav-Aids option is set to On, when the flashing light is Off, or
when fix position is out of the sector, the light color is displayed by using a faint

light color.
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35.1.5 Map Orientation
» 'MENU' + "Map Orientation" + 'ENTER'
Selects otientation of your chart according to. The default setting is Notth Up.
- North Up: the map is shown with North upwards.
- Track Up: the map is shown with the ship's current heading upwards. If
Track Up is selected, insert the Map Orientation Resolution angle by using the Jo)-
stick up and down in the range [5, 60] degtees (the default setting is 30°).

35.16 Mixing Levels
» 'MENU' + "Mixing Levels" + 'ENTER'

When the map coverage at the current zoom level does not fill the entire
screen, the chart plotter draws the rest of the map expanding the cartographic infor-
mation read from, at most, two zoom levels above the current zoom level. For this reason
the map is drawn three times: firstly it draws the two levels before the current level and then
the current level. The area covered by the cartographic data read from the previous levels is

identified by a dotted pattern. When the cursor is moved on an area not covered by data of

the current level the chart plotter zooms out to the first level covered by cartographic
data. The default setting is Off.

Note
The Mixing Levels function works only with the new C-CARDs. It also affects the speed of the redraw of the
screen. If this function is not used it maybe disabled.

3.5.1.7 Safety Status Bar
> 'MENU' + "Safety Status Bar" + "ENTER'

Itis possible to choose between the three following options:

ON : the Safety Status Bar is shown
OFF : the Safety Status Bar is not shown
ICON : the Safety Status Bar is not shown, but a warning alarm icon

is shown on the corner of the map screen as soon as any item
controlled by the DSI function returns an alarm condition.
The Warning Icon remains displayed until the alarm condi-
tion persists. Placing the cursor over it, a quick help message
is shown next to the DS icon, allowing to show the DSI bat.
In this case - when the DSI bar is opened via DSI alarm icon -
it is allowed to obtain information about each “active” DSI
box (the red ones): it is possible to select them by cursor move-
ment left/right, and a list of active alarms is shown undet-
neath the selected box. By pressing 'CLEAR', the DSI bar is
removed from the screen.
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5.1.8 USER POINTS

>» 'MENU' +'MENU' + "DISPLAY" +'ENTER' + "User Points" + "ENTER'
Sets On (icon + label), Off or Icon (only icon) the displaying of User Point.
The default setting is On.

5.1.9 SYMBOL SIZE

>» 'MENU' + 'MENU' + "DISPLAY" + 'ENTER' + "Symbol Size" + 'ENTER'
Sets Normal or Small the icon of User Point. The default setting is Normal.

5.1.10EVENT HANDLER TYPE

> 'MENU' +'MENU' + "DISPLAY" + '"ENTER' + "Event Handler Type" + 'ENTER'
Selects the type as Normal or By Key: if By Key is selected it is possible to set
the desired number for the Event. The default setting is Normal.

5.1.11 DATA WINDOW MODE

>» 'MENU' + 'MENU' + "DISPLAY" + 'ENTER' + "Data Window Mode" + 'ENTER'
Customizes the Text Area layout among Full Screen, Vertical, Text Area
with 5 boxes and Text Area with 8 boxes (see Par. 3.1.1). The default setting is 5
Boxes.

5.1.12 CURSOR WINDOW

> 'MENU' +'MENU' + "DISPLAY" + '"ENTER' + "Cutsot Window" + 'ENTER'
Enables (On) ot disables (Off) the display of the cursor window on the screen.
The default setting is On.

5.1.13 POSITION SYMBOL

> 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Position Symbol" + 'ENTER'
Selects the icon of the fix position displayed on the screen between Boat and
Standard. The default setting is Boat.

5.2 NAV DISPLAY MENU

The Nav Display menu allows to select CDI Scale and Navigation Page. Itis
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5.1.3 COURSE LINE

> 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Course Line" + 'ENTER'
The chart plotter will display a line with a circle at the end to indicate the
position your ship will reach at the set time based on current direction of travel and
speed. This is continuously updated to account for changes. Disables (Off) or sets
time as : 2, 10, 30 min, 1, 2 hours, Infinite. The default setting is Infinite.

5.1.4 SHIP ICON MODE
>» 'MENU' + 'MENU' + "DISPLAY" + '"ENTER' + "Ship Icon Mode" + "ENTER'
Sets the Ship Icon Mode between Steady or Blinking. When Ship Icon Mode
is Blinking, the ship icon (and the heading line) blinks every 1 second, otherwise
when it is Steady the Ship Icon (and the heading line) does not blink. The default
setting is Steady.

5.1.5 COORDINATE SYSTEM

> 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Cootdinate System" + 'ENTER'
Sets your preferred Coordinate System among ddd mm ss, ddd mm.mm,
ddd mm.mmm, UTM, OSGB, TD. The default setting is ddd mm.mmm.

If TD is selected a new TD Settings menu will be open on the screen:
>» 'MENU' + 'MENU' + "DISPLAY" + 'ENTER' + "COORDINATE SYSTEM" +

'ENTER' + 'TD' + 'ENTER"

Chain: Selects the preferred chain. The default setting is 9970.

Pair: Selects the pair of stations in the selected chain. The default setting is W X.

ASF 1/2: Sets the ASF (Additional Second Factor) for the slave in the selected chain.

The default setting is 0.

Alter: Turns On/Off the Alternate Solution in the chain. The default setting is Off.

5.1.6 MAP DATUM

> 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Map Datum" + 'ENTER'
Selects the Map Datum. WGS 1984 is the default Map Datum.

5.1.7 FIX DATUM

» 'MENU' + 'MENU' + "DISPLAY" + 'ENTER' + "Fix Datum" + 'ENTER'
Selects the Fix Datum. WGS 1984 is the default Fix Datum.
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When Safety Status Bar is On, this feature displays a status bar with six boxes
showing the status of certain functions. Any warning ot alarm condition is identified by the
red color to indicate possible risk.

® O ® @ ® ®

( NORMAL BEST MAP DATA OFF DECLUT. DANGERS CAUTIONS ]

Fig.3.5.1.7 - Safety Status Bar

Boxes definition is as follows:

@ Zoom

- Normal: when the chart is displayed at normal scale.

- U. Zoom: red when the chart is undet-zoomed out mote than twice not-
mal scale, gray otherwise.

- 0. Zoom: red when the chatt is over-zoomed in more than twice normal
scale, gray otherwise.

- Chart Lock: red when the chart is zoomed in more than twice normaln
scale, gray otherwise.

@ Best Map

Red when a more detailed chart is available under the cursor position.

(3 Data Off
Red when at least one of the following objects or layers is turned off (by the
uset): Depths/soundings; Wrecks/obstructions; Tracks/routes; Attention at-
eas; Nav-Aids.

@ Clear View
Displays when Clear View function is On.

(5) Dangers
Red when “Guardian Technology” detects one of the following objects: Land,

Intertidal, Depth Area, Rocks, Obstructions, Shoreline Constructions, Fish-
ing Facility, Wrecks, Dragged area, Diffusion area, Mooring facilities, Pingos
and Production installations.

(6) Caution

Red when “Guardian Technology” detects cautionary o restricted area.

3518 Palette
» 'MENU' + "Palette" + '"ENTER'
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It is possible to set the palette used to enhance the visibility of the screen
depending on the surrounding light condition. The possible choices are Normal, NOAA,
Night Vision and Sunlight. The default setting is Normal. Normal is rec- ommended
when the chart plotter is not exposed to the direct sunlight. When this mode is set the
maps are displayed in order to use colors as similar as possible to the ones used in the
original paper charts. Night Vision is recommended when the environment is dark in
order to reduce the glare of the display. The chart plotter displays maps and screen in
datker colors. Sunlight is designed to enhance the vis- ibility of the screen when the chart
plotter is exposed to the sunlight. The maps are much brighter than in the other modes
and the depth areas are filled with white color so different depth areas are not easily
distinguishable. NOAA Allows setting NOAA paper chart colors presentation.

3.5.19 Currents Prediction
» 'MENU' + "Cuttents Prediction" + '"ENTER'

It is possible to see the variation of the Tidal arrows on the selected area at any
given time. A window is shown on the low-left side of the chart, press '1. ST’ to set the
date and time manually, '2. Dicr' to decrease time and '3. INCR' to increase time, '4. Exir'
to exit.

3.5.1.10  Other Map Configurations
» 'MENU' + "Other Map Configurations" + 'ENTER'

This function allows the user to customize the following selections and is
divided into the following setting: Marine Settings, Depth Settings, Land Settings,
Underwater Objects Settings and Chart Settings.

Display Mode: To simplify the customization of the chart display, the map settings are
now re-organized in modes allowing the user to choose the preferred setting. Pre-
programmed settings are user selectable from Full, Medium, Low, Radar, Tides, Custom.
The default setting is Custom. The table below shows the selections for each mode:

Setting Full Medium Low Radar Tides Custom
(Default values)
Place Names On On On On On On
Name Tags On Off Off Off Off Off
Nav-Aids & Light Sectors On No Sector No Sector ~ No Sector Off On
Attention Areas On On Off Off Off On
Tides & Currents On Off Off Off On On
Seabed Type On Off Off Off Off On
Ports & Setvices On On Off On Off On
Tracks & Routes On Off Off Off Off On
Depth Range Min 3 Mt 3 Mt 3 Mt 3 Mt 3 Mt 3 Mt
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Menu Settings

There are other three menus, Display, Navigation Display and Advanced, to handle
the chart plotter information. Once you are in the Menu, use your [oystick to highlight the
item and press 'ENTER' to activate ot to proceed to the next selection menu.

5.1 DISPLAY MENU

Display Menu allows you to change how the chart plotter displays informa- tion.
It is possible to select this menu only when the active page is the Chart Display or the
Depth Graph (in split mode); so firstly select one of these pages, for example Chart
Display mode.
> 'PAGE' + "CHART DISPLAY" +'ENTER'
ot
> '#.Cuarr' (if it is present, whete #is 1,2, 3,4 ot 5)

5.1.1 AUTO INFO

>» 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Auto Info" + 'ENTER'
The type of Automatic Info is user selectable (see Par. 3.5.2).

5.1.2 SCREEN AMPLIFIER

> 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Scteen Amplifiet" + 'ENTER'

The Screen Amplifier function allows, when it is On and Home mode s set,

to place map on the screen related to the fix position and direction, so the map
shown is that before the ship. The default setting is Off.
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QU'Ck info on S|ng|e Destination Depth Range Max 10 Mt 10 Mt 10 Mt 10 Mt 10 Mt 10 Mt

Land Elevations On Off Off Off Off On

EXTERMAL DESTHATION Land Elevation Data On Off Off Off Off On

weToo2 Roads On off off off Off On

fj} Nm og;f-m POIs _ On off Off Off Off On

Lat/Lon Grid On Off Off Off Off On

Fig.4.9.1.8a - Quick Info on Single Destination Chart Boundaries On Auto Off Off Off Auto

Mixing Levels On Off Off Off Off Off

Note Value Added Data On off Off Off Off On
The window layout depends on the project. Chart Lock On On On On On On
Und. Objects Limit 9999Mt 10Mt 10Mt 10Mt 10Mt 10Mt

Rocks Icon+Depth Icon Icon Icon Icon Icon

Obstructions Icon+Depth Icon Icon Icon Icon Icon

Diffusers Icon+Depth Icon Icon Icon Icon Icon

Wrecks Icont+Depth Icon Icon Icon Icon Icon

Place Names: On/Off. The default setting is On.
> 'MENU' + "Other Map Configurations" + 'ENTER' + "Place Names" + 'ENTER'

Name Tags: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Name Tags" + '"ENTER"

Nav-Aids & Light Sectors : On (Nav-Aids & Light Sectors are shown)/Off (Nav- Aids
& Light Sectors are not shown)/No Sector (Nav-Aids are shown, Light Sectors are

hidden). The default setting is On.
» 'MENU' + "Other Map Configurations" + '"ENTER' + "Nav-Aids & Light Sectors"
+ 'ENTER'

Attention Areas: On/Off. The default setting is On. The Attention Areas will al- ways
be contour only when On.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Attention Areas" + 'ENTER'

Tide & Cutrents: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + "ENTER' + "Tides & Cuttents" +'ENTER'

Seabed Type: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + 'ENTER' +"Seabed Type" + 'ENTER'

Ports & Setvices: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" +'ENTER' +"Ports & Services" + 'ENTER'

Tracks & Routes: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Tracks & Routes" + 'ENTER'

Depth Range Min: Sets a min reference depth value. The default setting is 3 Mt.
» 'MENU'+ "Other Map Configurations" +"'ENTER' + "Depth Range Min" + 'ENTER'

Depth Range Max: Sets a max reference depth value. The default setting is 10 Mt.
> 'MENU' + "Other Map Configurations" +'ENTER' +"Depth Range Max" +'ENTER'

Land Elevations: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + '"ENTER' + "Land Elevations" + '"ENTER'
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Land Elevation Values: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Lan Elevation Values" +
'ENTER'

Roads: On/Off. The default setting is On.
> 'MENU' + "Other Map Configurations" + '"ENTER' + "Roads" + 'ENTER'

POIs (Points Of Information): On/Off. The default setting is On.
> 'MENU' + "Other Map Configurations" + 'ENTER' + "POIs" + 'ENTER'

Lat/Lon Grid: On/Off. The default setting is On.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Lat/Lon Gtid" + 'ENTER'

Chart Boundaries: On/Off/Auto. The default setting is On.
> 'MENU' + "Other Map Configurations" + 'ENTER' + "Chart Boundaties" +"ENTER'

Value Added Data: On/Off. The default setting is On.
> 'MENU' + "Other Map Configurations" + 'ENTER' + "Value Added data" + 'ENTER'

Chart Lock: On/Off. The default setting is On.
> 'MENU' + "Other Map Configurations" + 'ENTER' + "Chart Lock" + 'ENTER'

Underwater Object Limit: Selects the max depth value to display Underwater Ob- jects.

The default setting is 10 Mt.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Underwater Object Limit"
+ 'ENTER'

If value is set to 0 Mt, the Underwater Objects are not shown on the charts.
Menu options are grayed out.

If value is more than 0 Mt (i.e. 10 Mt), in the Range from 0 Mt to the selected
value the Underwater Objects are displayed according to their setting below.

Rocks: Off/Icon/Icon+Depth (*). The default setting is Icon.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Rocks" + 'ENTER'

Obstructions: Off/Icon/Icon+Depth (¥). The default setting is Icon.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Obstructions" + '"ENTER'

Diffusers: Off/Icon/Icon+Depth (¥). The default setting is Icon.
>» 'MENU' + "Other Map Configurations" + 'ENTER' + "Diffusers" + '"ENTER'

Wrecks: Off/Icon/Icon+Depth (¥). The default setting is Icon.
» 'MENU' + "Other Map Configurations" + 'ENTER' + "Wrecks" + 'ENTER'

Note (*)

Choose the option:
e OFF  : the object is not visible independently of the selected “Underwater Object
Depth VValue”
*  ICON : the object icon is visible without tags, in the range selected from “Underwater
Object Depth Value” option
*  ICONA+DEPTH : the object icon and tag is visible, in the range selected from “Under-
water Object Depth 1 alue” option
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- External Route

- Cruising Speed

- Fuel Consumption Rate
- Total Route length Route
- Initial Fuel Load

- Total Fuel Consumption
- Waypoints in Route

- Remaining Waypoints

- Distance to Destination
- Distance to Next Wpt

- Distance to Last Wpt

- TTG To Destination
- TTG To Next Wpt

- TTG to Last Wpt

- ETA to Destination

- ETA to Next Waypoint

- ETA to Last Wpt

: Name of the External Route (from PCMPN,0)
: Planned Cruising Speed (from PCMPN,1)
. Planned Fuel Consumption Rate (from PCMPN,1)
. Length from First to Last Wpt. (from PCMPN,1)
: Volume of Fuel available before the navigation was
started (Liters)
: Calculated Fuel consumption to navigate the whole route.
: No. of Wpts in the Route (from PCMPN,1)
: No. of Wpts from Dest to Last Wpt (from PCMPN,1)
. Distance from Ship to Destination (Calculated)
: Distance to travel from ship to the Wpt after the Destination
(calculated: Distance to Dest + Next Route Leg length)
: Distance to travel from ship to the End of the Route
(Calculated: Distance to Dest +Distance From Dest
to last Wpt received from PCMPN,1)
: Estimated Time to travel the “Distance to Last Wptf”.
Calculated using Cruising Speed.
: Estimated Time to travel the “Distance to Next Way-
point’ Calculated using Cruising Speed.
. Estimated Time to travel the “Distance to Last Wpt”.
Calculated using Cruising Speed
: Estimate Time of Arrival to the Destination Point.
Calculated: Current Time + “TTG To Destination”
: Estimate Time of Artival to the Waypoint after the
Destination. Calculated: Current Time + “TTG To
Next Waypoint”
: Estimate Time of Artival to the End of the Route.
Calculated: Current Time + “TTG To Last Wpt”

49.1.8 Quick Info
Route Navigation: Quick Info on the Destination

EXTERMAL Rte
[ROUTEON 1

Route Name, DESTINATION ID  Wpt1/4

DST TTG: Cons

(nm) (hhomm) Lit
Dest 1193 00:67 741
Last 8312 05:41 544
Route Length 71.19 Nm

Distance, TTG and Consumption from Ship to Dest
Distance, TTG and Consumption from Ship to Last Wpt
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Fig. 4.9.1.8 - Quick Info on Destination
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mode, the navigation to the external destination will be terminated. An appropriate
warning message will be shown to notify that the Navigation to the external destina- tion is
active and to confirm whether Slave mode can be set. Setting Slave mode, the C-link
navigation data will be deleted.

The C-link navigation data are deleted at Power Off.

4.9.1.5 C-link navigation data: Acquisition and Display
As soon as the C-link navigation data is received, the Slave parses the infor-
mation received and executes the relative actions depending on its current working status.

Important
When the Navigation to the external Destination is activated, the Slave Chart Plotter will show all
relevant c-link navigation data exactly like when the destination is not the external one: (Destination
Name, DST and BRG to Destination, calculate XTE, calculate TTG etc). These valnes will be
displayed all places where required and they will be used to format NMIEA-0183 output data.

4.9.1.6 Graphical representation on Map Display

DESCRIPTION

External Destination - RED Icon
WPT002

Next Waypoint - GREEN Icon QD
WPTO03
Navigation Leg - RED Line —

Fig.4.9.1.6 - Graphical Displaying

4.9.1.7  Route Data Report

When the Navigation to the External Route is received, it will be possible to display the
information related to the External Route by entering the Route Data Report.

External Route: ROUTEO01

Cruising Speed: 12.5kn Fuel Consumption Rate: 8.0/
Total Route length: 7119 Nm Total Fuel Consumption: 45.51
Waypoints in Route: 4 Initial Fuel Load: 2551
Remaining Waypoints: 4 Remaining Fuel: 2091
DST TTG: ETA: Cons
(nm) (hh.mmy (hh:mm} Lit
To Dest 11.93 00:57 |[11:54AM | 7.4

To Next Wpt | 15.97 01:16 1:10PM | 12.3
To Last Wpt 83.12 05:41 6:54 PM| 54.4

Fig. 4.9.1.7 - External route on Route Data Report
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3.5.2 GETTING AUTOMATIC INFO

The type of Automatic Info is user selectable.

» 'MENU' +'MENU' + "DISPLAY" + 'ENTER' + "Auto Info" + '"ENTER'

The possible settings are:

- Off: disabled, no automatic info shown at all.

- On Points: only on points. This is the default setting.

- On All: on all objects (points, lines, areas and text).

The Automatic Info On Points shows information when the cursor is placed
on points (as Port Services, Tides, lights, wrecks, rocks, buoys, beacons, obstruc-
tions, land markers, etc.).

The Automatic Info On All shows information when the cursor is placed on
points, on lines (as Depth contours, Traffic Separation, Territorial Sea, Cartographic
Lines etc.) on areas (Depth, Built-up, Sea, Attention, Restricted etc.) and on names
(on the beginning of the text -hot spot- or on any of the characters of the name -name
message box-).

The details on Land, Source of Data, Cartographic Area and Spot Soundings
are not shown.,
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cursor will be shown (see Par. 3.5.4).
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3521 Info on objects with Pictures
On the Quick Info, there will be the camera icon on the top bar of the
window if at least one of the objects found has one or more pictures associated.

OBJECT fiet]

Building, single -

to expand

Fig.3.5.2.1 - Example of Quick Info on objects with picture

On the Full Info, there will be the small camera icon on a corner of the square
containing the object icon or a big photo icon centered on the square for the object
without icon.

Land IEI
-Land elevation s
—National territorial area

Data source
Building

Multimedia Infermation

MultiMedia Object

ENTER to show the picture

Fig.3.5.2.1a - Example of Full Info on objects with picture

To see the picture press 'ENTER' when the object with a picture is highlighted.

Change Picture Size
When the picture is shown, it is possible to fit it to screen by pressing 'ENTER'.

3.5.2.2 Quick Info on Lakes

Upon viewing the chatt of a lake, you will click on to query the available infor- mation

Fig.3.5.2.2 - Example of Lakes info
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» 'MENU' + 'MENU' + "ADVANCED" + 'ENTER' + "C-LINK" + 'ENTER' + "Pri-
maty Station" + 'ENTER'

Master mode is the default factory setting. All regular chart plotters func-
tions are allowed. As soon as the Destination is placed, the master chart plotter will
start transmitting all C-Link navigation data. In Master mode the C-Link navigation
data received from the NMEA port is ignored. So, if the two chart plotters are both
operating in Master mode, the C-Link navigation data sent by the other chart plotter
never processed. Under such condition if the navigation is activated on one of the
two chart plotters, a warning message will be shown to notify that the C-Link navi-
gation data will be ignored by the other chart plotter.

4914 Slave Chart Plotter

Operating mode

To select the Slave mode (Secondary Station) follow the procedure:
>» 'MENU' +'MENU' + "ADVANCED" + 'ENTER' + "C-LINK" +'ENTER' + "Sec-
ondary Station" + 'ENTER'

When Slave mode is set, the chart plotter cannot manipulate the C-Link navigation
data anymore.

Stop current navigation

If the navigation was already active, it will be disabled as soon as Slave mode is set. An
appropriate warning message will be shown to notify that the Navigation is already active
and to confirm whether Slave mode can be set.

Inhibit Navigation operation

As soon as Slave mode is set, the destination cannot be placed anymore either the C-link
navigation data is received from the Master or not. Also, when the C-link navigation data is
received from the Master, it will not be allowed to deactivate the Navigation.

Inhibit Route following

While navigating to the route received from the Master the destination is reached (cither
applying distance or perpendicular criteria), the destination will not be moved to the next
waypoint on the route.

MOB handling

If the Navigation to the external destination is active and the the MOB key is pressed on the
Slave Chart Plotter, the MOB is placed but the navigation to the MOB is not activated.

Notes
While navigating to the external destination the Operating Mode is switched to Master
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prietary sentences: SPCMPN,1 and PCMPN,2. When the navigation is activated on the
Master, it starts outputting the C-Link navigation data. If the Slave is con- nected, all c-
link navigation data received are stored in its memory and the naviga- tion is started. The
information sent by the Master consists of the following values:

- Navigation mode  (To Single Destination / to a Route )
- Route Name (¥)

- Destination ID

- Destination Position

- Next Waypoint ID (¥)

- Range from Destination to next Waypoint (¥)

- Bearing from Destination to next Waypoint (¥)

- Route Length (*)

- Distance from Destination to Last Route Waypoint (¥)
- Remaining Route Legs (*)

- Planned Cruising Speed

- Average Fuel Consumption

- Initial Fuel Load

C-Link navigation data can refer to:
- Single Destination navigation
- Route Following navigation.

Values identified by () are sent only for Route Following navigation.

The Destination Icon, Navigation leg (Fix Position to Destination), the Next
Waypoint Icon and all other relevant C-Link navigation data will be shown on the
Slave chart plotter. Any variation of the C-Link navigation data on the Master will
be communicated to the Slave so to keep data aligned on both devices.

4.9.1.2  C-Link serial connection

The two chart plotters should be connected via serial ports. Any of the avail- able
ports can be used, the software will recognize automatically the serial ports used. A typical
connection is as follows:

CP1 CP2

X —>RX
RX <—1X
GND <—> GND

49.1.3 Master Chart Plotter

Operating mode
To select the Master mode (Primary Station) follow the procedure:
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When the cursor is placed over the icon, the icons of the available services are shown:

FRASH POND

| ®

[EHEd to expand

Fig. 3.5.2.2a - Quick Info: avallable services

If you press 'ENTER' all available information about the cartographic point under
the cursor will be shown. See the next paragraph.

3.5.2.3 Full Info on Lakes
The following is an example of Full Info on Lakes:

OUTDOOR RECREATIONAL AREA
L-STATE o
FISHING

| | SEASON AND BAG LIMITS
| | RECORDS
L HuNTING

| SEASON AND BAG LIMITS

FISHING

WALLEYE, TROUT (RATNBOW), TROUT (LAKE), TROUT
(BROWN), TROUT (BROOK), SUNFISH (PUMPKINSEED), SUNFISH
(BLUEGILL ), SHAD {(AMERICAN), SALMON (KOKANEE ), PIKE
(NORTHERN),PICKEREL (CHAIN),PERCH (YELLOW),PERCH
(WHITE),CATFISH (WHITE), CATFISH (CHANNEL ), CARP
(COMMON), BULLHEAD (BROWN),BASS (SMALLMOUTH),BASS
(ROCK),BASS (LARGEMOUTH), AMERICAN EEL

SLTIHEDIA THFORATIDN

v

e to shou picture

Fig.3.5.2.3 - Example of Full Info page

To see the "Fishing" object press MENU' (when the "Fishing" object is
highlighted). On the screen appears:

w

Walleye

Fig. 3.5.2.3a - Example of picture associated to the Fishing object
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3.5.3 INFO TREE AND EXPANDED INFO PAGE

This page combines the Info Tree and the Expanded Info pages; this gives the
advantage of showing the details of the object selected on the Info Tree while the cursor
is moving through the Info Tree’s items. The upper side of the page contains the Info
Tree and the Lower side contains the expanded information. While moving the cursor
through the Info Tree, all the relevant information of the selected object is shown on the
lower part of the page. When the selected object is a Tide Height, pressing 'ENTER' the
Tide page is shown.Pressing 'CLEAR' the page is closed. If the information shown
exceeds the page size, the user may scroll the page down pressing ‘2. Pace DN'. The '1.
HowE' restart the Expanded Info.

3.5.4 INFO FUNCTION

Place the cursor in any place you want and press:
> 'INFO'
to show the Info Tree and Expanded Info page (see Par. 3.5.4).

3.5.5 GETTING PORT INFO

Upon viewing the chart of a port or harbour, you will see a Port Info icon that
can be clicked on to query the available information immediately displayed with many
details. The Port Info icon is visible only if the Ports & Services option is On (default
setting).
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4.8.1 HOW C-LINK SYSTEM WORKS

When the CP is powered up, it switches into the “Stand-Alone Mode”. In this
wotk mode, the CP unit periodically scans all the available C-CARD slots search- ing for
MIRROR C-CARD:.

When one or more MIRROR C-CARD is found (in one or both CPs) a
special connection is established between the CPs to abilitate the MIRROR C-CARDs.
If a regular C-CARD which has previously activated a MIRROR C-CARD is re-
moved, even the MIRROR card will be not read anymore on the other unit.

4.9 C-LINK NAVIGATION DATA TRANSFER

This function allows transferring C-Link navigation data (Route Name, Des-
tination ID & Position, Next Waypoint ID & Position, Total Route length, Fuel
Consumption Rate, ETA, TTG etc.) (Hereinafter “C-Link navigation data”) between two
chart plotters linked through the C-Link system.

The chart plotters can be set to operate in two modes:

- MASTER mode (Primary Chart Plotter that sends data)

- SLAVE mode (Secondary Chart Plotter that receives data)

When the navigation is activated on the Master chart plotter, the C-Link
navigation data will be continuously sent to the Slave until the navigation is active.

If the Master is navigating to a Single Destination, the Slave will show the
Destination position and activate the navigation to it. If the Master is navigating to a
Route, the Slave will show the Route Leg composed by the Destination and the
Waypoint after the Destination (Next Waypoint) and activate the navigation to it.
Any variation to the current C-Link navigation data will be transferred from the
Master to the Slave. The Slave will be provided with a few dedicated pages to show
the C-Link navigation data received from the Master.

4.9.1 OPERATIONS

49.1.1 Introductive elements

It is important remark, once mote, that this function does not transfer the whole
route but just the information relative to the navigation. Such information will be removed
from the Slave Chart Plotter as soon as the navigation is terminated.

C-Link navigation data is exchanged by using two NMEA-0183 C-MAP pro-
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Remove Old Ot unnecessary @ to clean up your SD Card‘ Remember that thlS The available information is ShOWn in the Automatic Info WiﬂdOW where icons of

option permanently erases the file. the available services ate shown. To expand information about that object press 'l.
T Expanp' and to expand all available information for that cartographic point press '2. Exp
Arr.
4.7.4 SD CARD HANDLING s T
> 'MENU' + 'MENU' + "SD CARD" + 'ENTER' + '4, SD Carp' T m—— o
. T it = e
4741  Displaying SD Card contents é ® -
> 'MENU'+'MENU' + "SD CARD" + 'ENTER' + 4. SD Carp' + '1. $D Caro' ool //Q
It is possible to read the contents of the SD Catd. If the SD Card is not ; / B m O e—
present in the slot, a warning message appears. | T / — .. .
. e s f *E HET DOCK
47.42  Formatting SD Card g ?m’?’%
> 'MENU' +'MENU' + "SD-CARD" +'ENTER' +'4. SD CarD' + '2. ForMAT'
In order to be able to use a new SD Card you must format it first: this opera- 1 /\ AR
tion prepares the SD Card to receive and store information. : 3 e )
£ r : & #
4.7.43  Ordering the SD Card Directory ‘E\Qg; .
> 'MENU' +'MENU' + "SD CARD" + 'ENTER' + '4. SD Carp' + '3. Sort By' T G B - Q ; <
It is possible to order the file directory in three different modes: v aemo |77 o o au | voplew ¥ Py
- Press 'l. Name' to order by the filename; Fig.3.5.5a - Automatic Info window

- Press "2. TYpe' to order by the type of data;

- Press '3. TIME' to order by the time of file creation. 3.5.6 GETTING TIDE INFO

When you will see a Tide Info icon you can click on it to quety the available
information that will immediately be displayed.

4.8 C-LINK

C-Link system is a feature which allows to sharing the same cartographic data
between two chart plotter units (CP) linked via setial I/O port.

In order to activate C-Link function, a “MAX data C-CARD” (called REGU-
LAR C-CARD) must be inserted into one of the two chart plotters and a special
MAX data C-CARD (called MIRROR C-CARD) must be inserted on the other
chart plotter.

The two MAX data C-CARDs must have the same code and revision. So, the
MIRROR C-CARD can be utilized only on a chart plotter linked to another chart
plotter provided with the equivalent REGULAR C-CARD.

Itis important to point out that the two chart plotters must have the update
s/w versions that allow C-Link function.
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Place the cursor on the Tide symbol, a Automatic Info window is opened:
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Fig. 3.5.6a - Automatic Info on Tide

To display the Tide Graph page, press '1. ExpAND' (otherwise, press 2. Exp

ALL' to select all available information).
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4.6.2 PLACING CURSOR ON COORDINATES
>» 'MENU' + "FIND" + '"ENTER' + "COORDINATES" + '"ENTER'
Press the Joystick up/down to modify cootrdinates and the Joystick left/right
to move cursor to left/right. Press '1. CoNFIRM' (‘2. CANCEL' otherwise).

4.7 SD CARD MENU

The chart plotter allows to copy information to a SD Card. You can also return
the information to internal memory at a later time. This allows virtually unlimited storage.
>» 'MENU' +'MENU' + "SD-CARD" + 'ENTER'
Note

12 is possible to save and load the content of the SD Card used with previous versions of chart plotter based on
C-MAP technology. The vice versa is not possible anyway.

4.7.1 SAVING FILE

>» 'MENU' +'MENU' + "SD-CARD" + 'ENTER' + '1. Save'
A window is opened to insert the file name and the type of data to save.
Choose the type of data to save by pressing the related '1. MaRks', 2. Events', '3.
Routes' or '4. TRACKS'. Select the file name. At first a default name is shown: use the
Joystick to insert the name. Press 'ENTER'.

Note

When naming a file, you may have trouble finding a name that uniquely identifies the file’s contents. Dates,
Jor example, are T/ en used in filenames; however, they take up several characters, leaving you with
/zz‘t/e Jlexibility. The secret is to find a compromise, a point where you can combine a date with a word,
creating a unigue filename. The maximum length of the filename is 8 characters. The characters may be
numbers (0, ..., 9), letters (A,

«y Z) and spaces (for example legal identifiers are "ABC", "AA", "12121212", "A B C", "1
A 1", and s0 on.

4.7.2 LOADING FILE

» 'MENU' + 'MENU' + "SD-CARD" + 'ENTER' + '2. Loap'
Befote pressing '2. LoD, choose the file name in the list shown, using the
Joystick.

4.7.3 DELETING FILE

>» 'MENU' +'MENU' + "SD-CARD" +'ENTER' +'3. DELETE'
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4541 Track To Route
» 'TRACK' +"TRACK TO ROUTE" +'ENTER' + "TRACK TO ROUTE" + '"ENTER'

Executes the function that converts the given Track into a Route.

45.4.2  Advanced Menu
>» 'TRACK' + "TRACK TO ROUTE" + 'ENTER' + "ADVANCED" + 'ENTER'
Allows setting the parameters used by the function Track To Route.

Select Track

> 'TRACK' + "TRACK TO ROUTE" + 'ENTER' + "ADVANCED" +
'ENTER' + "SELECT TRACK NO." + 'ENTER'

Selects the Track input number.

Select Route

> 'TRACK' + "TRACK TO ROUTE" + 'ENTER' + "ADVANCED" +
'ENTER' + "SELECT ROUTE NO." + 'ENTER'

Selects the Route output number.

Select Off Course
» 'TRACK' + "TRACK TO ROUTE" + 'ENTER' + "ADVANCED" +
'ENTER' + "OFF COURSE" + 'ENTER'

Sets the conversion accuracy.

Select Waypoints Distance

> 'TRACK' + "TRACK TO ROUTE" + 'ENTER' + "ADVANCED" +
'ENTER' + "DIST WPTS" + 'ENTER'

Sets the minimum distance between Waypoints.

4.6 PAN FUNCTION

It is possible to select the pan function; pan allows you to shift area around the
cursor or a remote position to the centre of the screen.

4.6.1 MOVING CURSOR TO THE SCREEN CENTER

> 'MENU' +"FIND" +'ENTER' + "CURSOR" + 'ENTER'
The screen is redrawn and the cursor with the location you want to see will
shift to the center of the screen.
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Fig. 3.5.6b - Tide Graph

Using the Joystick, it is possible to move the cursor anywhere on the graph and
display the time, height (vertical cursor) and draught (horizontal cursor) on a particular
graph point. Also use "ZOOM IN' or 'ZOOM OUT" to go to previous or next day and
'ENTER' to set date (move the Joystick up/down to insett the preferred number and use it
left/right to move cursor to left/right).

Note

Tide graphs are an approximation of the tide and they should be used in conjunction with traditional tide
tables and navigational methods.

3.5.7 FIND FUNCTION

The chart plotter allows finding Port Services, Port By name, Port By Dis- tance,
Tide Stations, Wrecks, Obstructions, Points Of Interest, Lakes By Name, Lakes
Information, Cutsot, Coordinates and User Points.

35.7.1 Finding Port Services

To locate and display the nearest available facilities of a particular type (i.e. the

nearest Hospital, sailmaker, bank, etc.).
>» 'MENU' +"FIND" + 'ENTER' + "PORT SERVICES" + 'ENTER'

The icons of the available services are shown.

Use the Joystick to select any facility and press 'ENTER' or '1. FIND'. The list
of the nearest ports (up to 10) containing the facility, will be shown on the screen.

Then choose the port you want and press 'ENTER' o '1. Finp',

35.7.2 Finding Ports By Name

To select the Ports By Name function following the procedure:
>» 'MENU' + "FIND" + 'ENTER' + "PORTS BY NAME" + 'ENTER'
Shows the list of all ports stored on the C-CARD in alphabetical order and

allows to search ports by name to locate the potts on the map.
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3.5.7.3 Finding Ports By Distance

To select the Ports By Distance function following the procedure:
> 'MENU' + "FIND" + 'ENTER' + "PORTS BY DISTANCE" + 'ENTER'
Shows the list of all ports stored on the C-CARD in closest distance order

and allows to locate the ports on the map.

3.5.74 Finding Tide Stations
Finds the nearest Tide Stations (up to 10) on the map, from the boat position
- if a valid fix is received - or from the cursor position - if the received fix position is

not good.
>» 'MENU' +"FIND" + 'ENTER' + "TIDE STATIONS" + 'ENTER'

A new window will appear in few seconds. Choose the Tide Stations you
want and press ENTER' o '1. FIND' to display the Tide Graph page (see Par. 3.5.7b).
Press 'CLEAR' to display the Tide Station chosen.

3.5.7.5Finding Wrecks

Searches for Nearest Wrecks:
> 'MENU' +"FIND" + 'ENTER' + "WRECKS" + 'ENTER'
Use the Jopstick to select the port and "ZOOM IN'/"”ZOOM OUT' to select

next/previous page. Press ENTER' or '1. FIND' to locate the selected Wreck on the
map.

3.5.7.6 Finding Obstructions

Searches for Nearest Obstructions:
> 'MENU' +"FIND" + 'ENTER' + "OBSTRUCTIONS" + 'ENTER'
Use the Jopstick to select the portand "ZOOM IN'/"”ZOOM OUT" to select

next/previous page. Press ENTER' ot '1. FiNp' to locate the selected Obstruction.

35.7.7 Finding Cursor

Centets the cutsor on the scteen:
>» 'MENU' +"FIND" +'ENTER' + "CURSOR" + 'ENTER'

3.5.7.8 Finding Lakes Information

Searches for Nearest Lakes Info:
>» 'MENU' + "FIND" + 'ENTER' + "LAKES INFO" + 'ENTER'
It founds the Outdoor Recteational Area objects. See the following picture:
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45.3.2 Displaying Track
> 'TRACK' + "CONFIG" + 'ENTER' + "DISPLAY MODE" + 'ENTER'

Selects the displaying of the past course Visible or Hidden. The default set-
ting is Visible.

4533 Selecting Color
> 'TRACK' + "CONFIG" + 'ENTER' + "COLOR" + 'ENTER'

Press 'ENTER' as many times as needed to select the color for the selected
Track.

4534 Selecting Track memorizing type
> 'TRACK' + "CONFIG" + 'ENTER' + "RECORDING MODE" + 'ENTER'

Choose Distance (the chart plotter can store a fix when the distance from its
last stored position is greater than a defined distance) or Time (the chart plotter can
store a fix after a defined time). The default setting is Time.

4535 Selecting Time Step
> 'TRACK' + "CONFIG" + 'ENTER' + "TIME STEP" + 'ENTER'

When the tracking function is On and the type of Track storing is Time, the
chart plotter can store a fix after a defined time. Choose among 1, 5, 10, 30 sec, 1 min.
The default setting is 1 sec.

45.3.6 Selecting Distance Step
> 'TRACK' + "CONFIG" +'ENTER' + "DISTANCE STEP" + 'ENTER'
When the tracking function is On and the type of Track storing is Distance,
you can store a fix when the distance from its last stored position is greater than a
defined distance. Choose in the range 0.01, 0.05, 0.1, 0.5, 1.0, 2.0, 5.0, 10.0 Nm (the
distance unit is selected by the user, see Par. 3.2.1). The default setting is 0.01 Nm.

4537 Delete all Tracks
» 'TRACK' + "CONFIG" + '"ENTER' + "DELETE ALL TRACKS" + 'ENTER'

Deletes all the stored tracks. After pressing 'ENTER' a Warning window
appears: press '1. Conriru' (ot '2. CANCEL' to abott operation).

4.5.4 TRACKTO ROUTE MENU

» 'TRACK' +"TRACK TO ROUTE" + 'ENTER'
This function creates a Route from a pre-recorded Track. After pressing
'ENTER' a new window appears on the screen with the following options.
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4.4.3 EDITING EBL/VRM

> 'EBL/VRM' + 1. Accert'
Press 2. Eprr' to modify the line direction and the circle' radius. Use the
Joystick to move the dotted line in any direction you choose; in the same time the
radius changes. Press '1. AcCEPT' to confirm (‘2. CANCEL' otherwise).

4.5 USING THE TRACK FUNCTION

The chart plotter can be set up for recording your Track as you move and for
plotting this Track on the chart.

4.5.1 ENABLING TRACK STORING

>» 'TRACK' + "ACTIVATE" + 'ENTER'
or
> '#.Track ON' (if it is present, where # is 1, 2, 3,4 ot 5)
To enable the Track storing, It is not possible to use the Track storing if you
are not receiving a valid fix.

When Track storing is activated, to disable:
> 'TRACK' + "DEACTIVATE" + 'ENTER'

or
> '#.Track Orr' (if it is present, whete # is 1, 2, 3, 4 ot 5)

4.5.2 DELETING TRACK

> 'TRACK' + "DELETE" + 'ENTER'
Deletes all the Track or part of it. '1. BEGIN', '2. Exp' and '3. WroLE' allow
to identify the start or the end point of the segment to delete.

4.5.3 TRACK SETTING MENU

» 'TRACK' + "CONFIG" + 'ENTER'
On the screen a2 menu window is opened.

453.1 Selecting Active Track
> 'TRACK' + "CONFIG" + 'ENTER' + "ACTIVE TRACK" + 'ENTER'

Pressing 'ENTER' more times selects the number of the active Track. The
default setting is 1.

74 User Manual

P ENERE
DOBEE
i S staur.
e .
PN
A

Fig.3.5.7.8 - Outdoor Recreational Area objects

Use the cursor key to select any objects and press 'ENTER'. The list of the
nearest lakes containing the facility will be shown on the screen.

st BRG

I o e .

Fig.3.5.7.8a - Nearest Lakes list

Then choose the lake you want and press 'ENTER": the Full Info page is

shown.

3.5.7.9 Finding Lakes By Names

Selects the Lakes By Names function:
>» 'MENU' + "FIND" + 'ENTER' + "LAKES BY NAME" + 'ENTER'

Shows the list of all lakes stored on the C-CARD in alphabetic order. Press-
ing '"MENU' to insert the Lake name.

3.5.7.10  Finding POIs

Searches for Nearest Points Of Interest:
>» 'MENU' + "FIND" + 'ENTER' + "POINTS OF INTEREST" + 'ENTER'
A sub-menu is opened to find different categories of POLs.

3.5.7.11  Finding Coordinates

Allows to enter LAT/LON to locate a cartogtaphic point:
> 'MENU' +"FIND" + 'ENTER' + "COORDINATES" + 'ENTER'
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3.5.7.12  Finding User Points

Searches the User Points by name:
>» 'MENU' +"FIND" + 'ENTER' + "USER POINTS" + '"ENTER'

3.6 MAN OVERBOARD (MOB)

It is an important function useful in the case someone or something falls
ovetboard.

3.6.1 INSERTING MOB

Press 'EVENT/MOB' for 1 second to place MOB symbol at ship's coordi- nates:
the message "MOB Activate" is shown for a few second, then disappears. Data displayed in
Text Area are related to MOB.
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Fig. 3.6.1 - Man Overboard
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3.6.2 DELETING MOB

Press "'EVENT/MOB' for 1 second: a window to confirm the MOB deletion is
shown, press '1. Conriry' (or 2. CanceL' to abort operation). The MOB symbol remains
on the screen shaded until the next screen redraws.
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4.3 AB FUNCTION

Selects the Range and Bearing, AB function which allows you fast and easy
measurements of distance and bearing between two points.

4.3.1 INSERTING AB
> 'ENTER' + "AB" + 'ENTER'
The "A" point is positioned on the cursor position. Use the Joystick to move
the cursor in the desited place and then to place the "B" point press:
> 'ENTER' +"AB" + 'ENTER'
A straight line connects the two points "A" and "B": a cross identifies the
beginning and the end of the "A-B" line. A window appears with the distance (DST)
and bearing (BRG) values.

4.3.2 DELETING AB

To delete the "A" and "B" points and the line press '2. CLEAR.

4.4 EBL/NRM FUNCTION

The EBL option, "Electronic Bearing Line" is a dot line: the origin of the line is
cursor position.

The VRM option, "Variable Range Marker" is a circle and its radius is deter- mined
by the user. The circle's center is the cutsor position.

4.4.1 INSERTING EBL/VRM
> 'EBL/VRM'

A dotted line and a circle appears on the screen. A window with the DST
and BRG values is shown. The origin of the line and the circle's centre is the cursor
position: use the Joyszick to move the dotted line in any direction you choose; in the
same time the radius changes. Press '1. AccepT' to confirm (‘2. CANCEL' otherwise).

4.4.2 DELETING EBL/VRM

> 'EBL/VRM' + 1. Accert'
Press '1. DeLETE' to delete the line and the citcle.
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A window to confirm the deletion is shown. Press 1. CoNFIra' (‘2. CANCEL'
otherwise): the Event remains on the screen shaded until the next screen is redrawn.

Note

Ifyou try to delete any User Point used as GOTO a Warning window will appear, advicing that the User
Point belongs to an active Route and cannot be deleted.

4.2.2.3 Editing Event

»  Place cursot on existing Event +'3. Epir'

A window appears to modify Name, Color and Symbol the existing Event.

Use the Jopstick to select the field. If you have selected Name field, press
'ENTER'": use the Joystick to insert the character (8 characters max), press 'ENTER'.
If you have selected Color field, press 'ENTER": a window with 8 different colors
appears. Use the Joystick to select the color and press 'ENTER'. If Symbol field is
selected press 'ENTER'": a window with 16 different symbols appears. Use the Joy-
stick to select the Symbol and press 'ENTER'. The Notes field is used to insert an
alphanumeric text (max 15 characters). Then press "l. Accepr' to confirm the data
entered.

4224 Goto
»  Place cursor on existing Event + 'GOTO'
A circle encloses the Event symbol. A straight line is shown connecting the
Tatget with the ship's position. When the Target is placed, all navigation data are
referred to this Target.

4.2.2.5 Finding Event
> 'MENU' + "FIND" + 'ENTER' + "USER POINTS" + 'ENTER'

A window is opened to find a stored Event by entering its label. Use the
Joystick to insert the name and press 1. Conrirm' (‘2. CanceL' otherwise).

4.2.2.6 Finding information on Events: User Points List page
> 'MENU' + 'MENU' + "USER POINTS" + '"ENTER'

A full window is opened showing information about all stored User Points
(Marks, Events and Waypoints). Move up/down the Joystick to select the User Point
you wish. If the page contains more than 11 User Points, the list continues in the
next pages. See Par. 4.1.2.8.

4227 Send and Receive Events
> 'MENU' + 'MENU' + "USER POINTS" + 'ENTER' + 'SEND' + 'ENTER'
To send all User Points to an external device through the serial port.
» 'MENU' + 'MENU' + "USER POINTS" + 'ENTER' + 'RECEIVE' + 'ENTER'

To read User Points from the NMEA input port.
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For the Experienced User

Now that you are familiar with your new chart plotter, it is time to found about a
large number of advanced features that you will find helpful.

4.1 MORE ABOUT CREATING AND USING ROUTES

At anytime, you may add or delete Waypoints, see a Route summary, re- verse the
direction of the Route or erase the entire Route.

4.1.1 ROUTES

The following functions are used for the Route management.
>» 'MENU' +'MENU' + "ROUTE" + 'ENTER'

41.1.1 Selecting Route
» 'MENU' +'MENU' + "ROUTE" + 'ENTER' + "SELECT" + '"ENTER'

Use the Joystick or the numeric keys to select the preferred Route number.
The following functions are available.

Displaying Route
>» 'MENU' + 'MENU' + "ROUTE" + 'ENTER' + "SELECT" + 'ENTER' + '1. SELECT'
The Route, shown by straight segments, is centered on the screen, with the cursor on the

central Waypoint.

Editing notes

> 'MENU' + 'MENU' + "ROUTE" + 'ENTER' + "SELECT" + 'ENTER' + '2. NotEs'
Another window is shown: use the J@/;tif/é to insert the notes (this is possible only if you
have already created a Route). Press 'ENTER' to confirm (‘CANCEL' otherwise).
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Hide/Show Route
» 'MENU' + 'MENU' + "ROUTE" + '"ENTER' + "SELECT" + 'ENTER' + '3. Hiog/
SHow'

Allows to hide or show the selected Route on the scteen.

Route Color

>» 'MENU' + 'MENU' + "ROUTE" + 'ENTER' + "SELECT" + 'ENTER' + '4. Coror' It
is possible to change color. After pressing '4.CoLor' another window is shown: use the
Joystick to choose the preferred color (among 8 colors) for the Route. Press

"1. AccepT' to confirm (2. CANCEL' otherwise).

Find Route

>» 'MENU' +'MENU'+ "ROUTE" + 'ENTER' + "SELECT" + 'ENTER' + '5. FInD'
Allows to find the Route in the Select Route page inserting the desired number (then to
display the selected Route on the screen press 'l. SELECT%.

41.1.2 Deleting Route
>» 'MENU' +'MENU' + "ROUTE" + 'ENTER' + "DELETE" + 'ENTER'
A window is opened: press '1. CoNFIRM' to delete (‘2. CANCEL' otherwise).
The Route remains on the screen shaded until the screen is redrawn.

4113 Finding information on Route: Route Report
» 'MENU' + 'MENU' + "ROUTE" + 'ENTER' + "REPORT" + 'ENTER'

ROVTE 1 DFTA REPORT E0/08/08 1837 _ Fuel consumption per hour

OST/BRG:

Waypoint identifer

TOT.DST: ETE; FUEL: .
Fuel consumption between the
Waypoint and the first Waypoint

of the route

Waypoint position

Estimated Time Enroute
(Time from the first Waypoint

- of the route)
Distance and Bearing between - ' ;
the previous Waypoint and the Total Distance (Distance from
current one + e 5w 5 e the first Waypoint of the route)

Fig.4.1.1.3 - Route Data Report page
If there are more than 9 Waypoint shown, use the Joystick to select another page.

Changing Speed & Fuel values

> 'MENU' +'MENU' + "ROUTE" + 'ENTER' + "REPORT" + 'ENTER' +'1. FueL.'
» 'MENU' + 'MENU' + "ROUTE" +'ENTER' + "REPORT" + 'ENTER' + '2. SpEED'

Insert value by using the Joystick and pressing'ENTER' (CLEAR' abort operation).
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4215  Goto
» Add Matk ('ENTER' + "MARK" + 'ENTER') or Place cursor on existing Mark

Press 'GOTO": a circle encloses the Mark symbol. A straight line is shown
on the screen connecting the Target with the ship's position. When the Target is
placed, all navigation data are referred to this Target.

4.2.1.6 Finding Mark
> 'MENU' + "FIND" + 'ENTER' + "USER POINTS" + 'ENTER'
A window is opened to find a stored Mark by entering its label. Use the
Joystick to insert the name and press '1. ConFIrM' (‘1. CANCEL' otherwise).

4.2.1.7 Finding information on Marks: User Points List page
>» 'MENU' +'MENU' + "USER POINTS" + 'ENTER' + "LIST" + 'ENTER'
A full window is opened showing information about all stored User Points
(Marks, Events and Waypoints). Move up/down the Joystick to select the User Point
you wish. If the page contains more than 11 User Points, the list continues in the
next pages. See Par. 4.1.2.8.

41.2.8 Send and Receive Marks
» 'MENU' + 'MENU' + "USER POINTS" + 'ENTER' + 'SEND' + 'ENTER'

To send all User Points to an external device through the serial port.
>» 'MENU' +'MENU' + "USER POINTS" + 'ENTER' + 'RECEIVE' + 'ENTER'
To read User Points from the NMEA input port.

4.2.2 EVENTS

In Navigate mode you may place a location with an Event symbol and num- ber,
directly on the ship's position. Move the cursor to exit from Navigate mode; place the
cursor on an Event to access the following functions.

4221 Adding Event
>» 'EVENT/MOB'
ot
> '#.Evenr' (if itis present, whete #is 1,2, 3,4 ot 5)
An Event is placed directly on the ship's position.

Note
1t is possible to place an Event only if the chart plotter is making a valid position fix.

4222 Deleting Event

»  Place cursor on existing Event + '2. DELETE'
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4.2.1.3 Deleting Mark
» Add Mark ('ENTER' + "MARK" + 'ENTER') or Place cursor on existing Mark

Press '2. DELETE" a window to confirm the deletion is shown. Press '1. Con-
FIRM' (‘2. CANCEL' otherwise): the Mark remains on the screen shaded until the next
screen is redrawn.

4214 Editing Mark

»  Add Matk (‘ENTER' + "MARK" + 'ENTER") or Place cutsor on existing Matk

Press '3. Epir'. A window appears to modify Name, Symbol, Colo, coordi-

nates, Dangerous status and notes of the existing Mark. Use the Joystick to select the
field. If you have selected Name field, press 'ENTER'": use the Joystick to insert the
character (8 characters max), then press 'ENTER'. If Symbol field is selected press
'ENTER'": a window with 16 different symbols appears. Use the Joystick to select the
symbol and press 'ENTER'. If you have selected Color field, press 'ENTER'": a
window with 8 different colors appears. Use the Joystick to select the color and
press 'ENTER'. If Coordinates field is selected, press 'ENTER' and then use the
Joystick to insert the value. The Danger field is used to switch Yes/No the Danger
status. If Danger status is Yes and the Guard Zone Alarm (see also Par. 5.3.4.4) is set
to any value from 0.01 to 9.99 NM and the distance between the fix position and the
selected Mark is less than Guard Zone Alarm value, a warning message is shown.
The Notes field is used to insert an alphanumeric text (max 15 characters). Then
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Reversing Route

>» 'MENU' +'MENU' + "ROUTE" + 'ENTER' + "REPORT" + 'ENTER' + '3. REVERSE'
Reversing a Route plan is most typically used to return to the point where the Route
originally started.

4.1.1.4 Selecting Route Color
>» 'MENU' +'MENU' + "ROUTE" + 'ENTER' + "COLOR" + 'ENTER'
It is possible to change Route color. After pressing 'ENTER' a window
with 8 different colors appears. Use the Joystick to select the Route legs color and
press '1. Accepr' (‘2. CanceL' otherwise).

4.1.15 Send and Receive Route
» 'MENU' + 'MENU' + "ROUTE" + 'ENTER' + "SEND" + 'ENTER'
To transmit the Active Route information onto the NMEA output port.
The NMEA WPL & RTE messages are sent to the output pott.

> 'MENU' +'MENU' + "ROUTE" +'ENTER' + "RECEIVE" + 'ENTER'
To save Route information received from the NMEA input port. The re-
ceived route is saved on the Active Route, overwriting it. The NMEA WPL & RTE
messages are sent to the input port.

4.1.2 WAYPOINTS

You may add Waypoints, delete Waypoints from a Route, move any Way- point
in the Route to another location, insert a Waypoint between two existing ones, find any
Waypoint at anytime. Every time you place the cursor on a Waypoint the following
functions ate available.

41.2.1 Adding Waypoint

Place the cursor on position you want and then:
>» 'ENTER' + "WAYPOINT" + 'ENTER'
or
> '#.Wer' (if it is present, where #is 1,2, 3,4 ot 5)
The Waypoint appears on the screen on the cursor position. An info win-
dow is shown containing Route number, data and time, Waypoint name, symbol and
Latitude/Longitude, information on previous and - if the Waypoint is not the last of the
Route - also on the next Waypoint. To create a Route inserting additional Waypoints repeat
the above described sequence.
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41.2.2

> Add Waypoint (ENTER' +

ing the Waypoint to the new position, is shown:

60

Moving Waypoint

"WAYPOINT"

Waypoint

+'ENTER') or Place cursor on existing

Press '1. Move'. Use the Joystick to move the cursor: a dotted line, connect-

S“as. 119N
25380 . G3all

MOB

TG
HH: MM

DST
Hn

9.263 |

279°

“Bristol

AT

—

510000

CURSOR

50004 . 742N
000°41 . 240E
DISTANCE

453000

1. ACCEPT np 3 2. CANCEL Em"

b

14 Eon2on

Fig.4.1.2.2 - Moving Waypoint function (1)

To place the Waypoint in the new position, choose the new place and press
"1 Accept' (ot 2. CANCEL' othetwise).
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Press '1. Accrpr':

Fig.4.2.1.2 - Moving Mark function (1)
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The Matk is placed in the new position, the "old" Mark, remains on the

Fig.4.2.1.2a - Moving Mark function (I1)

screen shaded until the scteen is redrawn.
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4.1.2.9 Send and Receive Waypoints
>» 'MENU' + 'MENU' + "USER POINTS" + 'ENTER' + 'SEND' + 'ENTER'
To send all User Points to an external device through the serial port.
> 'MENU' + 'MENU' + "USER POINTS" + 'ENTER' + 'RECEIVE' + 'ENTER'
To read User Points from the NMEA input port.

4.2 USING MARKS & EVENTS

You may place a Mark, as it is called, at your cursor position, while Event is
created at your vessel position.

4.2.1 MARKS

You may tag a location on the chart with a Mark symbol and number, which you
can record for later use. Every time you place the cursor on a Mark the follow- ing
functions are available.

4211 Adding Mark
Place the cursor on position you want and then:
> 'ENTER' + "MARK" + 'ENTER'
ot
> '#.Marx' (if it is present, whete # is 1, 2, 3, 4 ot 5)
The new Mark appears on your cursor position. An info window containing
Matk name, symbol and Latitude/Longitude is shown.

42.1.2 Moving Mark
» Add Matk (‘'ENTER' + "MARK" + 'ENTER') or Place cursor on existing Mark
Press '1. Move'. By moving the cursor with the Joystick, a dotted line con-
necting the Mark with the new position is shown:
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41.2.3

Fig.4.1.2.2a - Moving Waypoint function (1)

Deleting Waypoint

> Add Waypoint ‘'ENTER' + "WAYPOINT" + 'ENTER') or Place cursor on existing

Waypoint
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Fig.4.1.2.3 - Deleting Waypoint (1)
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Press '2. Derere'. A Warning message is shown to advise that Waypoint is
currently used in a Route: press 1. Conriry' to confirm deletion (‘2. Cancer' othet- wise).
The Waypoint is deleted and a new line between previous and next Waypoint is shown.
The deleted Waypoint remains shaded until the screen is redrawn.

4327 .656MN | 1T r—

HH: M1

P16~ 18. 138E bl ———. |38 ——c

] 2l e

503000,

500000

433000

r L dl

% L _sRouen ]
J_E s
0010000 i 000 00 00 j E 00100 00 4 Eoozo000

Fig.4.1.2.3a - Deleting Waypoint (I1)

4124 Editing Waypoint
>  Add Waypoint ‘'ENTER' + "WAYPOINT" + 'ENTER') or Place cutsor on existing
Waypoint
Press '3. Eprt' to modify a Waypoint. A window will be shown with Name,
Symbol, Color and Latitude/Longitude of the Waypoint, advicing about what Way-
point data are modifiable:
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4.1.2.8 Finding information on Waypoints: User Points List page
» 'MENU' +'MENU' + "USER POINTS" + 'ENTER' + "LIST" + 'ENTER'
A full window is opened showing information about all stored User Points.
Move up/down the Joystick to select the User Point you wish. If the page contains
more than 11 User Points, the list continues in the next pages.
Graphic symbol and identifier

Cursor or Ship coordinates

Type of User Point
(Mark, Event or Waypoint)

e
e
e

e

BEIZEEEEGE

" T Distance and Bearing
from the cursor or

User Point position [cvo] [erme] [pwmeme] [wmm] from Ship’s position
Fig.4.1.2.8 - User Points page

Note
Ln the list to identify the current Target a circle encloses the User Point symbol.

Viewing Waypoint in map display

» 'MENU' + 'MENU' + "USER POINTS" + 'ENTER' + "LIST" + 'ENTER' + "1. View'
The chart plotter exits from the User Points List page and redraws the chart. The selected
point appears, with the cursor placed on it. Press 'CLEAR' to exit and re- turn to User
Point List page.

Finding Waypoint in the User Points List page

» 'MENU' +'MENU' + "USER POINTS"+ "LIST" + 'ENTER' + 'ENTER' + '2. Finp' A
window appeats: insett the name by using the Joystick. Press 'ENTER'": in the User Points
List page the chart plotter shows the Waypoint in reverse video screen.

Deleting Waypoint
> 'MENU'+'MENU' + "USER POINTS"+ "LIST" +'ENTER' +'ENTER' +'3. DELETE'
A warning message is shown; press 1. Conrra’ (‘2. CANCEL' othewise).

Deleting all stored User Points

> 'MENU'+'MENU'+"USERPOINTS"+ "LIST" + 'ENTER' +'ENTER' + '4. DeL ArL'
A warning message is shown, press '1. ConrirM' (‘2. CANCEL' otherwise).
Note

Ifyou try to delete any User Point used as GOTO a Warning window will appear, advicing that the User
Point belongs to an active Route and cannot be deleted.
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49043 . 800N

A window is opened to find a stored Waypoint by entering its label: Se-e6. 119N MOB },’,jm ——
= DST BRG @
=5 66 151N — o —— 285~ 30. 2461 s 8. 503[F 277
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::nan i} ﬁj \bj - "ﬂDB;\D W? 2000
| Eu_‘_‘_‘_‘_‘_‘_‘_‘_‘_‘_‘_u_‘_._‘_‘_._j F
"""""""""" [~ 503000 uuuagiuu
o hanne §MM EDIT WAYPOINT
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500000 004 \‘\x Name: [A15]5K] Sumbol: X
FIND USER POINT uoes 50°84.623N F 17
Hane: mea? 1500000 888026. 8?3“ — E E M50.00.80
£ B 7 & T ] Wotes: ROUTE @1
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?mﬂﬂﬂ (ﬂ\ﬁj@wﬁ % ; o 001 00 00 " 000 00 00 E 0010000 Flg. 4-1-2.4 = Edlt Waypolnt
Fig.4.1.2.7 - Finding Waypoint function (1) Use the Jostick to select the field. If you have selected Name field, press 'ENTER?: use the
. . ' . 1N S— . . .
Use the Joystick to insert the name and press 1. CONFIRM' (‘2. CANCEL' othet- Joystick to insett the character (8 characters max), press 'ENTER'. If Symbol field is selected
wise). For example, if the inserted name is WO007, the cursor is placed on this Way- press 'ENTER', a window with 16 different symbols appeats:
point and the info window is shown:
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[ o ox prd] e s - — — Fig.4.1.2.4a - Waypoint symbols
Fig.4.1.2.7a - Finding Waypoint function (11 .
’ 9 T v Use the Joystick to select the Symbol and press 'ENTER'. If you have se-
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lected Color field, press 'ENTER'": a window with 8 different colors appears. Use the
Joystick to select the color and press 'ENTER'. If Coordinates field is selected, press
'ENTER' and then use the Joystick to insert the value. The Notes field is used to
insert an alphanumeric text (max 15 characters). Then press 1. Accepr' to confirm
the data entered.

Se“se. 121NN MOB e —_——

4125  Goto
»  Add Waypoint ‘'ENTER' + "WAYPOINT" + 'ENTER') or Place cutsor on existing
Waypoint

Press'GOTO": acircle encloses the Waypoint symbol. On the screen a straight
line is shown, connecting the Target with the ship's position. When the Target is

placed, all navigation data are referred to this Target. ;oE ]
e} T BEm oo
4126  Insert ' ) )
1.2, nserting Waypoint [ e o
. . .o L S:@ | N
Every time you place the cursor on the segment connecting two existing . 1 2090 1
Waypoints of a Route the following function is available. R Rl
T b | 1. ACCEPT WM 2. CRNCEL E w4 00100 00 % 0000000 1 0010000 g
»  Place cussor on Route leg - - - —
Fig.4.1.2.6a - Placing Waypoint between two existing ones (I1)
Se“es6. 121N MOB o —t
205~ 30. 1001 o 0.602|" 277° Once you have positioned the cursor at new location, press 1. Accepr"

S0 06. 1=21M MOB e —t
Pes-Ta.81 1l paT 0.660 | 276°
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.

ﬁ’ws a0

e
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001°03. 5731

009N
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| r 07.0
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1 095° M
14490000 14.49.0000
o ‘ 1. INSERT v W 0010000 W 0000000 1 E 0010000 1 i
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ol
Fig.4.1.2.6 - Placing Waypoint between two existing ones (I)
Press '1. Insert'. The line between the two Waypoints is turned into a dotted line: - _ e J _ _ — -
move the cursor to the new position. When the cursor is stationary for 1 second or 2, the Fig.4.1.2.60 - Placing Waypoint between two existing ones (I11)
line will "rubber—baqd”, drawing a dotted line between the last Waypoint and the cursor, 4127 Finding W int
and another dotted line between the cursor and the next Waypoint: .2 Inding vvaypoin

>» 'MENU' + "FIND" + 'ENTER' + "USER POINTS" + 'ENTER'
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SITEXK

Customer Service

If you encounter problems during the installation or operation of
this product, or cannot find the information you need, please
contact Sitex Customer Service.

The contact numbers and e-mail address for Sitex Customer
Service are:

Sitex Main Office.................. +1-631-996-2690
SiteX FaX....oovoou i, +1-631-996-2693

Sitex Service E-mail address: service@si-tex.com

Sitex Customer Support E-mail address: customerservice @si-
tex.com

Sitex Main Office Address:

25 Enterprise Zone Drive, Ste 2
Riverhead, NY 11901

Technical Support is available from 9:00 AM to 5:00 PM
Eastern Standard Time, Monday through Friday.
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